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This manual is part of a set of Printer Controller EB-105EX™ documentation that 

includes the following manuals for users and system administrators:

• The Quick Start Guide summarizes the steps for configuring the Printer Controller 

EB-105EX and printing. It also describes how to access the online documentation. 

• The User Software Installation Guide describes how to install software from the 

User Software CD to enable users to print to the Printer Controller EB-105EX 

and set up printing connections to the Printer Controller EB-105EX.

• The Configuration Guide explains basic configuration and administration of 

the Printer Controller EB-105EX for supported platforms and network 

environments. It also includes guidelines for setting up UNIX, Microsoft 

Windows NT 4.0/2000, and Novell NetWare servers to provide printing 

services to users. 

• The Printing Guide describes the printing features of the Printer Controller 

EB-105EX for users who send jobs from their computers.

• The Job Management Guide explains the functions of job management utilities, 

including Command WorkStation™, Command WorkStation LE™, and Fiery 

DocBuilder Pro™, and how to use them to monitor and manage jobs on the Printer 

Controller EB-105EX. This manual is intended for an operator, administrator, or 

user with the necessary access privileges, who monitors and manages job flow, and 

troubleshoots problems that may arise.

• The User Addendum describes advanced PostScript print options in the 

Windows 98/Me, Windows NT 4.0/2000/XP, and Apple Mac OS printer drivers.

• Release Notes provide last-minute product information and workarounds for some 

of the problems you may encounter.
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License

EFI grants you a non-exclusive license to use the Software and accompanying documentation (“Documentation”) included with the Product. The Software is 
licensed, not sold. You may use the Software solely for your own customary business or personal purposes. You may not rent, lease, sublicense or lend the Software 
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Proprietary Rights
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Confidentiality

The Software is confidential, proprietary information of EFI and you may not distribute or disclose the Software. You may, however, permanently transfer all of 
your rights under this Agreement to another person or legal entity provided that: (1) such a transfer is authorized under all applicable export laws and regulations, 
including the U.S. Export Administration Regulations, (2) you transfer to the person or entity all of the Software and Documentation (including all copies, 
updates, upgrades, prior versions, component parts, the media and printed materials, and this Agreement); (3) you retain no copies of the Software and 
Documentation, including copies stored on a computer; and (4) the recipient agrees to the terms and conditions of this Agreement. 

Remedies and Termination

Unauthorized use, copying, or disclosure of the Software, or any breach of this Agreement will result in automatic termination of this license and will make 
available to EFI other legal remedies. In the event of termination, you must destroy all copies of the Software, Documentation, and all component parts thereof. 
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will perform in substantial conformance to the Documentation when the Product is used as authorized by EFI’s specifications. EFI warrants the media containing 
the Software against failure during the above warranty period. EFI makes no warranty or representation that the Software will meet your specific requirements, 
that the operation of the Software will be uninterrupted, secure, fault-tolerant, or error free, or that all defects in the Software will be corrected. EFI makes no 
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EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY AND TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, EFI 
MAKES AND YOU RECEIVE NO WARRANTIES OR CONDITIONS ON THE SOFTWARE, EXPRESS, IMPLIED, STATUTORY, OR IN ANY 
OTHER PROVISION OF THIS AGREEMENT OR COMMUNICATION WITH YOU, AND EFI SPECIFICALLY DISCLAIMS ANY IMPLIED 
WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF THIRD 
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Limitation of Liability

TO THE MAXIMUM EXTENT PERMITTED BY LAW, EFI AND ITS SUPPLIERS SHALL NOT BE LIABLE FOR ANY DAMAGES, INCLUDING 
LOSS OF DATA, LOST PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES 
ARISING FROM THE SALE, INSTALLATION, MAINTENANCE, USE, PERFORMANCE OR FAILURE OF THE SOFTWARE, HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY. THIS LIMITATION WILL APPLY EVEN IF EFI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF THE PRODUCT REFLECTS THIS ALLOCATION OF RISK. BECAUSE SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, 
THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

You are hereby notified that Adobe Systems Incorporated, a Delaware corporation located at 345 Park Avenue, San Jose, CA 95110-2704 (“Adobe”) is a third-
party beneficiary to this agreement to the extent that this agreement contains provisions which relate to your use of any software, font programs, typefaces, and/or 
trademarks licensed or supplied by Adobe. Such provisions are made expressly for the benefit of Adobe and are enforceable by Adobe in addition to EFI. ADOBE 
WILL HAVE NO LIABILITY WHATSOEVER TO YOU FOR ANY ADOBE SOFTWARE OR TECHNOLOGY LICENSED HEREUNDER.

Export Controls

EFI’s Products are subject to U.S. export laws and regulations, including the U.S. Export Administration Regulations, as well as foreign export laws and regulations. 
You agree that you will not use, distribute, transfer, export, or re-export any portion of the Product or the Software in any form in violation of any applicable laws 
or regulations of the United States or the country in which you obtained them.

U.S. Government Restricted Rights:

Use, duplication, or disclosure of the Software by the United States Government is subject to restrictions as set forth in FAR 12.212 or DFARS 227.7202-3 -
227.7202-4 and, to the extent required under U.S. federal law, the minimum restricted rights as set out in FAR 52.227-14, Restricted Rights Notice (June 1987) 
Alternate III(g)(3)(June 1987) or FAR 52.227-19 (June 1987). To the extent any technical data is provided pursuant to the Agreement, such data is protected per 
FAR 12.211 and DFARS 227.7102-2 and to the extent explicitly required by the U.S. Government, is subject to limited rights as set out in DFARS 252.227.7015 
(November 1995) and DFARS 252.227-7037 (September 1999). In the event that any of the above referenced agency regulations are modified or superceded, the 
subsequent or equivalent regulation shall apply. The name of the Contractor is Electronics for Imaging. 

General

The rights and obligations of the parties related to this Agreement will be governed in all respects by the laws of the State of California exclusively, as such laws 
apply to contracts between California residents performed entirely within California. The United Nations Convention on Contracts for the International Sale of 
Goods and any other similar convention does not apply to this Agreement. For all disputes related to this Agreement, you consent to the personal and exclusive 
jurisdiction and venue of the state courts in San Mateo County, California and the federal court for the Northern District of California. This Agreement is the 
entire agreement held between us and supersedes any other communications or advertising with respect to the Software. If any provision of this Agreement is held 
invalid, such provision shall be deemed modified to the extent necessary to be enforceable and the other provisions in this Agreement shall continue in full force 
and effect.

If you have any questions, please see EFI’s web site at www.efi.com.

Electronics for Imaging
303 Velocity Way
Foster City, CA 94404
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xiii About this manual

This manual is intended for Printer Controller EB-105EX operators and 

administrators, or users with the necessary access privileges, who monitor and 

manage job flow, manipulate jobs, and troubleshoot problems that may arise. 

It describes the functions and features of the Fiery® job management utilities—

Command WorkStation, Command WorkStation LE, Fiery Spooler™, and Fiery 

WebSpooler™—for the purposes of job management and quality control.

NOTE: The term “EB-105EX” is used in this manual to refer to the Printer Controller 

EB-105EX. The name “Aero” is used in illustrations to represent the EB-105EX. 

The term “copier” is used to refer to the supported copier. The term “Windows” is 

used to refer to Windows 98, Windows Me, Windows NT 4.0, Windows 2000, and 

Windows XP, wherever appropriate.

About this manual
This manual is organized as follows:

• Chapter 1 provides preliminary background information about job management 

and introduces the Fiery job management utilities. It explains how to set up an 

operator-controlled print environment and discusses job workflows that commonly 

occur on the EB-105EX.

• Chapter 2 introduces the Command WorkStation and Command WorkStation LE 

user interfaces. It provides information on basic Command WorkStation and 

Command WorkStation LE functions, such as printing EB-105EX information 

pages and setting preferences.

• Chapter 3 provides instructions on monitoring and managing job flow using 

Command WorkStation and Command WorkStation LE. It explains how to hold, 

process, print, and cancel selected jobs, and how to track and archive printed jobs.

• Chapter 4 describes how to preview, edit, and merge jobs using the Preview windows 

of Command WorkStation and Command WorkStation LE. 

• Chapter 5 describes how to use the Imposition feature of DocBuilder Pro to arrange 

the pages of your print job in special layouts for folding, binding, or cutting after 

printing. The Imposition feature is available only if you have installed the 

DocBuilder Pro option for Command WorkStation.

Introduction



xiv Introduction

• Chapter 6 provides instructions on using advanced aspects of DocBuilder Pro to 

create custom layouts and take full advantage of Imposition features.

• Chapter 7 describes Fiery WebSpooler and Fiery Spooler, which you can use to view 

and manage EB-105EX job activity. 

• Appendix A provides an overview of the terms and concepts of imposition, 

including various folding, binding, and cutting methods.

• Appendix B describes the built-in templates available from the Imposition feature of 

DocBuilder Pro.

• Appendix C provides basic troubleshooting information.

Terminology

Specific terms are explained as they are introduced. However, the following general 

terms are used throughout:

• PostScript (PS)—A computer language designed as a page description language. 

The EB-105EX uses this language for imaging the page and communicating with 

applications and the copier.

The term “PostScript” can also be used to refer to PDF data jobs. PDF is a 

structured form of PostScript that provides the ability to preview, scale, and reorder 

pages. Where applicable, the term “PDF” is specifically used to refer to PDF data 

or jobs.

• Job—A file consisting of PostScript commands and comments that describe the 

graphics, sampled images, and text that should appear on each page of a document, 

and the printer options that should be used in printing, such as media or color 

rendering style.

• Spool—Write to a disk. Used in this manual to refer to a PostScript print job being 

saved to the EB-105EX hard disk in preparation for processing and printing.
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• RIP—Acronym for raster image processing, which changes PostScript 

commands into descriptions of each mark on a page. In common use as a 

noun, a “raster image processor” (RIP) is the computer processor that performs 

this function.

The EB-105EX RIP changes text and graphics commands in PostScript into 

specifications for each dot of toner deposited on a page by the copier.

• Process—The term “process” is used interchangeably with the term “RIP” 

in this manual to refer to raster image processing.

• Print—The task of rendering, or imaging, a page or job on a print device.

These concepts explain how the EB-105EX and the copier work together as a 

powerful printing system. 





11-1 Job environments

This chapter explains the basic principles of job management in an operator-controlled 

print environment and provides an overview of the EB-105EX job management 

utilities.

Job environments
The EB-105EX supports several control levels of printing, job management, and 

Setup, and gives you the flexibility to choose a configuration that corresponds to the 

requirements of your site.

Levels of job control

The following descriptions outline the range of levels of job control that may exist in 

your environment:

• At one extreme, an operator in a high-volume printing environment controls the 

entire job flow and all printing. Print jobs arriving from remote users are spooled to 

the EB-105EX hard disk and stored until the operator decides it is time to print 

them. Additional functions (job overrides, prioritizing, and font management) are 

reserved for the operator.

• At the other extreme, anyone on the local network can control all printing and 

EB-105EX functions; operator intervention is not required. Users can print from 

their computers to any of the published print connections. Anyone can use the job 

management utilities to control any print job.

You can implement intermediate levels of job control in your environment. However, 

the job management utilities are best suited for an operator-controlled environment.

Chapter 1:
About Job 
Management



11-2 About Job Management

Setting up an operator-controlled environment

This manual assumes you are working in an operator-controlled environment with 

responsibility for managing job flow. To establish an operator-controlled environment, 

you or the administrator must complete the following tasks:

Set up password privileges—The administrator must set up separate passwords for 

operator access and administrator access to the EB-105EX. For instructions on setting 

up passwords, see the Configuration Guide.

Publish the Hold queue only—The administrator must enable only the Hold queue, 

not the Direct connection or the Print queue, in Setup. (For more information, see the 

Configuration Guide.) This ensures that all jobs sent by remote users are spooled and 

held on the EB-105EX, in preparation for job management by the operator.

Establish communication between users and the operator—The operator and 

remote users must agree on a method for communicating print needs, such as 

Fiery FreeForm™ masters. Users can attach instructions to jobs using print option 

and notes fields (see page 1-5).

Understanding job flow
In an operator-controlled printing environment, remote users send jobs to the Hold 

queue of the EB-105EX. Using a job management utility, the operator views the list of 

held jobs and decides when to release each job for processing and printing. 

The operator may also intervene during the workflow, stopping jobs as they are 

processed or printed, placing jobs on hold for future action, or overriding the 

user-defined print settings for a job. In some cases, the operator may even modify a 

job, duplicating or removing pages, or merging it with pages from another job before 

releasing it for printing.
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Spooling, processing, and printing

To understand job flow through the EB-105EX, it is helpful to consider the three main 

stages of printing.

Spooling—When a job file is sent over the network by a remote user or imported from 

disk, it arrives at the EB-105EX and spools to a location on the hard disk. After 

spooling completely, the job is held on the hard disk, where it awaits further 

instructions from the operator. 

Processing (RIPping)—When the operator releases the job file, it undergoes raster 

image processing (RIPping) at the EB-105EX. During processing, the job file is 

interpreted as a raster image. This raster image contains the data required by the copier 

to print the job the way its originator intended. In the raster image, data associated 

with each dot is rendered on the copier. The raster data tells the copier whether or not 

to apply toner to each position on the page.

Printing—After processing, the job typically moves on to the printing stage. During 

this stage, the raster image associated with the job is transferred from the EB-105EX to 

the copier at a high speed. The raster image is then rendered onto paper, and the job is 

printed.

While original job files are saved to the EB-105EX hard disk, raster images are typically 

deleted after printing. The operator can issue commands to save and hold the raster 

image on the hard disk along with the original job file. Saving the raster image to the 

hard disk offers two advantages: raster files are already processed, so they print quickly, 

and each part of the raster file is still identified with a page in the original document, so 

you can access individual pages of a saved raster file.

Spooling

Processing

Printing
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Visualizing job flow

As the operator, your job management tools permit holding and releasing a job at any 

stage of the job flow. In the following illustration, solid boxes indicate the types of job 

status flags you may see in the Command WorkStation or Command WorkStation LE 

Active Jobs window. Boldface items represent commands you can issue from a job 

management utility to release held jobs.

Printed

Spooling

Processing (RIPping)

PostScript data

Process (RIP) and Hold Print and HoldPrint

Print

PostScript and 
raster data

Spooled/Held

Processed/Held

Processing (RIPping)

PrintingPrinting Printing

Processing (RIPping)
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Each command initiates a job workflow:

Print—When you issue the Print command for a held job, the job is released for 

immediate processing and printing on the EB-105EX. 

Print and Hold—When you issue the Print and Hold command for a held job, the job 

is released for immediate processing and printing. However, a raster copy of the 

original job remains in processed/held status, even after the original job has finished 

printing.

Process (RIP) and Hold—When you issue the Process and Hold command (Command 

WorkStation or Command WorkStation LE) or RIP and Hold command (Fiery 

WebSpooler or Fiery Spooler) for a held job, the job is released for processing and then 

held in processed/held status indefinitely. To release the job for immediate printing, 

you must issue the Print command. A raster copy of the original job remains in 

processed/held status, even after the original job has finished printing.

Communicating with users
As the operator, you can use the job management tools to communicate with users 

who originate print jobs. You can help users become better informed about the 

EB-105EX and the copier so that they can choose the appropriate options for their 

jobs by supplying the following information:

EB-105EX device information

• The name of the EB-105EX on the network and the names of the network servers 

sharing it

• The IP address or DNS name of the EB-105EX, to allow users access to Fiery 

WebTools™

• List of default copier settings and other settings
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• List of installed fonts

If their applications do not download fonts automatically, can users download fonts 

to the EB-105EX? Should users embed fonts in documents or supply them for you 

to download? 

• List of installable options for the copier

• Available media, alternative choices, and standard tray/media configurations

Printing information

• Duration for jobs to be held on the EB-105EX before deletion

• Instructions for setting up the printer on client computers

• Sources of PostScript printer drivers, PPDs, and additional information

• Recommended PPD settings

• Conflicting settings and common PostScript errors

• FreeForm information regarding use of master and variable data

• Imposition information regarding use of the DocBuilder Pro option

• Requirements for Notes fields (information that appears in the Job Log)

For example, department name, account code, phone number, or extension. 

Is particular information mandatory at your site?

• Suggestions for what to enter in the Instructions field
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What the operator should check

Users specify print options with jobs they send to the printer. They can also use the 

Instructions and Notes fields to communicate special print requirements and 

accounting information. Together, this user-specified information that accompanies 

the job is called a job ticket.

As the operator, we recommend you tell remote users which job ticket information you 

check when receiving a print job, and the information you require in order to print 

jobs they send.

Job ticket information

You can view and potentially override the print options specified by users by checking 

job ticket information. To display user-defined print options, choose Properties in 

Command WorkStation or Command WorkStation LE (see page 3-15), or Override 

Print Settings in Fiery WebSpooler or Fiery Spooler (see page 7-7).

Notes fields

Users can enter accounting information in the Notes fields, such as:

• User name and phone number

• Billing information

• Job cost information

Instructions field

Users can enter information in the Instructions field to communicate special print 

requirements, such as:

• Priority, due date, and request for notification

• Number of copies 

• Type and quantity of paper 

• Request to hold job for future printing or reprinting, and future job instructions

• Instructions to merge job with another job

• FreeForm information regarding the use of master and variable data

• Imposition instructions
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Overview of the job management utilities
The EB-105EX includes the following job management utilities: 

• Command WorkStation

• Command WorkStation LE

• Fiery WebSpooler

• Fiery Spooler

These utilities are designed for use by operators who must track and manage jobs and 

oversee general job flow through the EB-105EX. All the utilities offer the following job 

management features:

• Monitoring activity on the EB-105EX and controlling job flow

• Viewing and overriding user-defined print option settings

• Editing and merging job files

• Tracking job activity through the Job Log 

Command WorkStation

The most powerful of the job management utilities, Command WorkStation can be 

installed on a Windows computer that has a network connection to the EB-105EX. 

In addition to the job management functions previously outlined, Command 

WorkStation offers a customizable user interface for monitoring and managing jobs on 

multiple EB-105EX servers simultaneously.

For an introduction to the Command WorkStation user interface, see Chapter 2. 

For information on monitoring, managing, and archiving jobs with Command 

WorkStation, see Chapter 3.

Command WorkStation LE

Command WorkStation LE allows operators and users to manage jobs from a 

Mac OS X computer with a network connection to the EB-105EX. 

The features of Command WorkStation LE are similar to those of Command 

WorkStation. For information on Command WorkStation LE, see Chapters 2 and  3.
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Fiery WebSpooler and Fiery Spooler

Fiery WebSpooler and Fiery Spooler are similar in appearance and functionality. 

However, you access the utilities in different ways. You can access WebSpooler through 

a Java-enabled Web browser residing on any computer with a networked connection to 

the EB-105EX. Fiery Spooler must be installed on a networked Mac OS computer and 

can only be used on that computer.

WebSpooler and Fiery Spooler offer job management functions similar to those of 

Command WorkStation. The default WebSpooler user interface is shown in the 

following illustration; the user interface of Fiery Spooler is similar.

For information on using Fiery WebSpooler or Fiery Spooler, see Chapter 7.

Spool area

RIP area

Print area

Thumbnail B

Thumbnail A

Spool status bar

RIP status bar

Print status bar
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This chapter provides an introduction to the Command WorkStation and 

Command WorkStation LE graphical user interfaces. To follow along in the software 

as you read the chapter, log in to the application with an Operator or Administrator 

password, as described on page 3-2.

Once you are logged in, you can tour the application. Your exploration will be more 

complete if you have some jobs in the Active Jobs window (jobs in the Hold queue), 

and can send more jobs from a nearby computer.

This chapter also describes Setup functions such as printing EB-105EX information 

pages, setting application preferences, and managing EB-105EX fonts.

NOTE: Unless otherwise specified, information in this chapter applies to both 

Command WorkStation and Command WorkStation LE. Sections that apply 

exclusively to Command WorkStation are denoted by an asterisk (*). Sections that 

apply exclusively to Command WorkStation LE are denoted by a dagger (†). In cases 

where the two applications are nearly identical, only Command WorkStation 

illustrations are shown.

The graphical interface
Command WorkStation and Command WorkStation LE provide a graphical means to 

monitor, preview, and manage jobs on one or more EB-105EX servers. You can hide or 

rearrange the components in the interface to create custom layouts that meet your job 

management needs.

Chapter 2:
Introduction 
to Command 
WorkStation 
and Command 
WorkStation LE
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The following illustrations show the components of Command WorkStation and 

Command WorkStation LE. 

1 Menu bar (see page 2-15)

2 Job status indicators (see page 2-10)

3 Action buttons (see page 2-11)

4 Active Jobs window (see page 2-4)

5 Jobs window (see page 2-5)

6 Activity Monitor (see page 2-8)

1
2

3

4 6

5

Command WorkStation
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The following sections describe each component in Command WorkStation and 

Command WorkStation LE.

1 Action buttons (see page 2-11)

2 Active Jobs window (see page 2-4)

3 Jobs window (see page 2-5)

4 Activity Monitor (see page 2-8)

1

2

3

4

Command WorkStation LE
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Active Jobs window

The Active Jobs window dynamically displays the status and job ticket information of 

jobs that are currently being held, processed, or printed on the EB-105EX. The title 

bar displays the total number of jobs and the total number of held jobs currently being 

monitored.

The Active Jobs window is always displayed. You cannot hide or drag it to a different 

location. By issuing job management commands, you release held jobs in the window 

for processing and printing, cancel jobs currently processing or printing, and send jobs 

back to held status for future action. For more information on the status flags displayed 

in the Active Jobs window, see “Job status indicators” on page 2-10.

Server selection menu

Job ticket information

Command WorkStation

Job ticket information

Command WorkStation LE
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In the Active Jobs window, you can:

• Monitor and manage jobs on the EB-105EX (see page 3-7).

• Customize job ticket information (see page 3-8).

• Monitor jobs on multiple EB-105EX servers* (see page 2-12).

Jobs window

The Jobs window displays information about jobs that have printed successfully 

through a connected EB-105EX. The window is divided into four layered panels. 

Click the selection tabs at the bottom of the window to move between different panels. 

The following illustration shows the Jobs window for Command WorkStation, which 

is nearly identical to the Jobs Window for Command WorkStation LE.

In each panel, the title bar displays the name of the panel and the total number of 

jobs displayed. 

All panels of the Jobs window allow you to customize the job ticket information 

(see page 3-8).

Printed Jobs tab
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Printed Jobs panel

The Printed Jobs panel lists all jobs that have been printed from the EB-105EX. Newly 

printed jobs are added to the top of the list. The Printed Jobs panel lists all printed jobs 

until the job limit (determined by the administrator in EB-105EX Setup) is reached. 

When the first job over the limit is printed, the oldest job is deleted from the Printed 

Jobs list. 

Archive panel 

The Archive panel lists all files and jobs stored in the job archive. 

For information on using the Archive panel, see “Archiving jobs” on page 3-28. 
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FreeForm panel 

The FreeForm panel lists the names of all master files used for FreeForm variable data 

printing. Jobs listed in the FreeForm panel represent preRIPped master files stored on 

the EB-105EX.

The FreeForm panel is not available if you logged in as Guest. For information on 

working with FreeForm jobs and the FreeForm panel, see page 3-24.

Job Log panel

The Job Log panel lists all processed and printed jobs and includes the date and time 

the jobs were printed. 

The Job Log panel is not available if you logged in as Guest. For information on using 

the Job Log panel, see page 3-30.
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Activity Monitor

The Activity Monitor displays a summary of the job activity on all EB-105EX servers 

or a selected EB-105EX. The activity shown can include jobs released for spooling, 

processing (RIPping), or printing. Held jobs do not appear in the Activity Monitor.

Display the Activity Monitor by choosing Activity Monitor from the Windows menu. 

In Command WorkStation, you can use the server selection menu in the Active Jobs 

window to display job activity for an individual EB-105EX, or for all servers (see 

page 2-12).

All Servers view*

In Command WorkStation, the All Servers view of the Activity Monitor summarizes 

the activity on all connected EB-105EX servers. 

• Server Name—Each EB-105EX appears in a Server Name bar. Click the bar to 

expand or collapse activity information for a particular EB-105EX. 

• Spooling, processing, and printing jobs—When you expand the Server Name bar 

for an EB-105EX, any current job activity on that EB-105EX appears next to a 

corresponding status box (spooling, processing, or printing). If the EB-105EX is 

connected to more than one copier, the copier handling the job is listed under the 

job name. When no activity occurs on the EB-105EX, the status boxes read Idle.

• Error conditions—When an error occurs, the Server Name bar for the affected 

EB-105EX appears highlighted in red. Details of the error appear under the 

expanded bar.
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Selected Server view

When you select an individual EB-105EX in Command WorkStation, the Activity 

Monitor provides a more detailed summary of the current activity on that EB-105EX. 

In Command WorkStation LE, the Activity Monitor displays the current activity on 

the connected EB-105EX. Animated images provide visual indications of the job 

activity.

Jobs being held, waiting to process, or waiting to print are not displayed.

The following illustration shows the Selected Server view of the Activity Monitor for 

Command WorkStation, which is nearly identical to the Activity Monitor for 

Command WorkStation LE.

Four sections appear for a selected server. Click the appropriate title bar to expand or 

collapse the display of each section.

Spooling—Displays the file name of the job spooling to the EB-105EX hard disk.

Processing—Displays the file name of the job currently being processed (RIPped), 

along with an animated preview of the page currently being processed.

Spooling 

Processing 

Printing 

General Info
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Printing—Displays the file name of the job currently being printed, and the page 

number currently printing. With multiple copies, the copy number is also displayed.

General Info—Displays the total and available hard disk space, and the total and 

available memory of the EB-105EX. This section also provides the EB-105EX name, 

system software version, technical support number, copier name, and date the copier 

was last calibrated.

Job status indicators

Job status indicators define the color in the Active Jobs window and Activity Monitor 

to indicate the current status of jobs. For information on how each indicator relates to 

job flow on the EB-105EX, see “Understanding job flow” on page 1-2.

In Command WorkStation, a key for the job status indicators is displayed below the 

menu bar:

The color-coded job status indicators identify:

spooling (white)—The job file is being copied to the EB-105EX hard disk.

spooled/held (light yellow)—The job has been downloaded to the EB-105EX hard 

disk and requires job management instructions from the operator.

waiting to process (light blue)—The job is queued to be processed (RIPped).

processing (medium blue)—The job is currently being processed (RIPped).

processed/held (dark yellow)—The job has been processed (RIPped) and requires job 

management instructions from the operator.

waiting to print (light green)—The job is queued to be printed on a copier connected 

to the EB-105EX.

printing (bright green)—The job has been received by a copier connected to the 

EB-105EX.
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Action buttons

Action buttons provide convenient access to frequently used job management 

commands. Issue these commands by choosing them from the menu bar or the 

context-sensitive menus. For a detailed description of each Action button command, 

see the table on page 2-15.

TO ISSUE AN ACTION BUTTON COMMAND

1. Select a job in the Active Jobs window or the Jobs window.

2. Click the desired Action button.

When a command is unavailable in the current context, its Action button appears 

dimmed.

Preview windows

The Preview windows allow you to view thumbnail previews of selected jobs. You can 

also use the Preview windows to reorder and delete pages of a job, and to merge pages 

from several jobs into a single, merged job. 

Command WorkStation

Command WorkStation LE
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Monitoring single or multiple EB-105EX servers*
In Command WorkStation, you can set the Active Jobs window, Jobs window, and 

Activity Monitor to display job information for a single EB-105EX or all connected 

EB-105EX servers.

TO SPECIFY THE EB-105EX BEING MONITORED

1. Click the arrow in the server selection menu of the Active Jobs window, Jobs window, 

or Activity Monitor.

A menu appears, listing the names of all connected EB-105EX servers.

2. To display jobs for an individual EB-105EX, choose the EB-105EX from the list. 

To monitor jobs for all connected EB-105EX servers, choose All Servers.

Print jobs on the specified EB-105EX servers appear.

Customizing the graphical interface
Command WorkStation and Command WorkStation LE offer you the flexibility of 

showing, hiding, rearranging, and docking user interface components to fit your 

workflow needs. For example, you may only need a few components, or you may 

prefer to arrange components side by side for ease of use. In Command WorkStation, 

you can also choose from one of three preset layouts.

You can also customize the appearance of job ticket information in the Active Jobs and 

Jobs windows. For more information, see page 3-8.
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Using layout styles*

Command WorkStation provides three preset and three customizable layout styles. 

When you choose a command corresponding to a layout style, the display updates to 

show a specific arrangement of components.

TO CHOOSE A LAYOUT STYLE

• Choose Layouts from the Window menu, and then choose a layout style from the 

submenu that appears.

You can choose from three preset layouts (Default, Style 1, or Style 2) or three custom 

layouts. For a description of the components included with each of the preset layouts, 

see page 2-21.

To define and change the configurations associated with the three custom layout styles, 

see the following section.

Showing, hiding, and arranging components

Window menu commands allow you to show or hide window components. You can 

also drag components to different locations in the window, and dock components side 

by side.

NOTE: You cannot hide or drag the menu bar and Active Jobs window to different 

locations. These components always appear in the Command WorkStation or 

Command WorkStation LE window.

TO SHOW OR HIDE A COMPONENT

• Choose the command associated with the component from the Window menu.

When a component is displayed, a check mark appears next to it in the 

Window menu.
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TO MOVE A COMPONENT TO ANOTHER LOCATION

• Click the window grip (three vertical lines) on the left side of the component’s 

title bar (Command WorkStation) or click the component’s title bar (Command 

WorkStation LE), and drag the window to the desired location.

Undocked components float in front of other components and appear with standard 

window frames. Drag the blank title bar of the window to move the component or 

drag the edges of the window to resize the component. Click the window Close box 

to hide the component.

NOTE: When the Jobs window is docked, you can resize it vertically by clicking and 

dragging its top edge.

TO DOCK OR UNDOCK A COMPONENT

• Double-click the window grip in the component’s title bar.

TO SAVE THE CURRENT DISPLAY CONFIGURATION AS A LAYOUT STYLE 
IN COMMAND WORKSTATION*

1. Choose Save Layout from the Window menu.

2. In the dialog box that appears, choose the style you want to update, and, if desired, 

rename the style.

3. Click OK to save the new layout style.

Using commands
You can perform a wide variety of functions using Command WorkStation and 

Command WorkStation LE commands. Access the commands from menus in the 

menu bar at the top of the Command WorkStation or Command WorkStation LE 

window. When one or more jobs are selected, you can choose job management 

commands from context-sensitive menus. In addition, you can issue some job 

management commands by clicking their Action buttons (see page 2-11).
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Menu bar

The menu bar contains commands for Command WorkStation or Command 

WorkStation LE. When a command is unavailable in the current context, it appears 

dimmed in the menu. When a command appears with a check mark, choosing it 

toggles the command, turning it off.

NOTE: In the following table, an asterisk (*) indicates that the command or menu is 

available for Command WorkStation only. A dagger (†) indicates that the command or 

menu is available for Command WorkStation LE only.

Menu Command Submenu command Description

CWS LE† About Fiery 
Command 
WorkStation LE...†

Displays information about the current version of 
Command WorkStation LE.

Preferences...† Allows you to change the Command WorkStation LE 
preference settings.

Services† The commands under this submenu are disabled for 
Command WorkStation LE.

Hide CWS LE† Minimizes and hides the Command WorkStation LE 
application window. The application continues to run in 
the background.

Hide Others† Minimizes and hides all currently running applications other 
than Command WorkStation LE. The hidden applications 
continue to run in the background.

Show All† Maximizes and brings to the foreground all currently 
running applications.

Quit CWS LE† Exits Command WorkStation LE.
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File Import Job Imports a job file into the Direct, Hold, or Print queue of 
the EB-105EX.

Archived Job Imports an archived job file into the Hold queue of the 
EB-105EX.

Export Active Window...* Exports the contents of the current window to a 
tab-delimited text file.

Printed Jobs Window...* Exports the contents of the Printed Jobs panel to a 
tab-delimited text file.

Job List...† Exports the contents of the Active Jobs window to a 
tab-delimited text file.

Job Log...† Exports the contents of the Job Log panel to a 
tab-delimited text file.

Print* Job Log...* Prints the current Job Log on a local printer.

Active Window...* Prints the contents of the current window on a local printer.

Exit* Closes the Command WorkStation application window.

Close† Closes the Command WorkStation LE application window.

Edit Find Allows you to search selected EB-105EX servers for jobs that 
match certain search criteria.

Preferences* Allows you to change the Command WorkStation 
preference settings.

Undo, Cut, 
Copy, Paste†

Applies the specified action on the selection. For more 
information, see Mac OS Help.

Menu Command Submenu command Description
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Actions Print Prints the selected job in the Active Jobs window, 
Printed Jobs panel, or Archive panel. 

Delete Deletes the selected job in the Active Jobs window, 
Printed Jobs panel, FreeForm panel, or Archive panel. 
You cannot delete jobs that are currently spooling, 
processing, or waiting to print.

Duplicate Duplicates the selected held job in the Active Jobs window. 

Rename Allows you to rename the selected held job in the Active Jobs 
window, or the selected job in the Printed Jobs panel or 
Archive panel. 

Hold Holds the selected job waiting to process in the Active Jobs 
window, or the selected job in the Printed Jobs or Archive 
panel, and marks the job with either the spooled/held flag or 
the processed/held flag.

Process and Hold Processes the selected job in the Active Jobs window, Printed 
Jobs panel, or Archive panel, and holds a copy of the job. 
The copied job is marked with the processed/held flag. 

Print and Hold Prints the selected job in the Active Jobs window, Printed 
Jobs panel, or Archive panel, and holds a copy of the job. 
The copied job is marked with the processed/held flag. 

Remove Raster 
Data

Removes the raster data associated with the selected 
processed/held job in the Active Jobs window, or the selected 
raster job in the Printed Jobs or Archive panel; leaves the 
original PostScript job in place.

Properties Allows you to view and override print settings for the 
selected job in the Active Jobs window or Printed Jobs panel, 
or view print settings for the selected job in the FreeForm 
panel or Archive panel.

Menu Command Submenu command Description
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Actions
(cont.)

Preview Opens the selected job in a Preview window. You can 
preview held jobs that reside in the Active Jobs window, as 
well as jobs that reside in the Printed Jobs panel, FreeForm 
panel, or Archive panel.

Archive Archives the selected held job in the Active Jobs window, 
moving it to the Archive panel.

Send To...* Sends the selected held job in the Active Jobs window to 
another EB-105EX.

Cancel Processing Cancels processing of the selected job in the Active Jobs 
window. This command is available only for jobs displaying 
the processing status flag.

Cancel Printing Cancels printing of the selected job in the Active Jobs 
window. This command is available only for jobs displaying 
the printing status flag.

Impose* Allows you to apply imposition settings to the selected held 
job in the Active Jobs window.

Mixed Media 
Setup*

Allows you to specify different media types for different page 
ranges in the selected spooled/held job.

Menu Command Submenu command Description
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Server Log In/Log Out Allows you to log in or log out of the EB-105EX and add 
and remove EB-105EX servers from the list. 

Setup* Opens the Setup options for the EB-105EX. 

Restart Server Allows you to restart the EB-105EX without shutting down 
the EB-105EX hard disk. This command is available only if 
you are logged in as Administrator.

NOTE: After you restart the EB-105EX, you may need to log 
in to the EB-105EX again to reestablish the connection.

Reboot Server Allows you to restart the EB-105EX, after shutting down the 
EB-105EX hard disk. This command is available only if you 
are logged in as Administrator.

NOTE: After you restart the EB-105EX, you may need to log 
in to the EB-105EX again to reestablish the connection.

Job Log* Export* Exports the contents of the Job Log panel to a tab-delimited 
text file.

Export and Clear* Exports the contents of the Job Log panel to a tab-delimited 
text file, and clears the contents of the job log for the 
EB-105EX.

Clear Job Log...† Clears the contents of the job log for the EB-105EX.

Clear Server... Allows you to specify which types of jobs to delete from the 
EB-105EX.

Menu Command Submenu command Description
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Server
(cont.)

Print Pages Allows you to print the following information pages:
• Configuration page
• Font List (for PostScript fonts)
• Job Log
• PCL Font List
• PCL Test Page
• PS Test Page
Command WorkStation also allows you to print the 
following information pages about the EB-105EX to 
the local printer:
• Archive Log
• Queues

Reorder Jobs* Allows you to reorder the priority of jobs that are waiting 
to process or print.

Manage Font Allows you to download fonts to the EB-105EX. You can 

also delete fonts currently resident on the EB-105EX.

Suspend Printing Suspends or pauses printing on the EB-105EX.

Resume Printing Resumes printing on the EB-105EX. 

Menu Command Submenu command Description
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Window Layouts* Default* Displays the following Command WorkStation 
components:
• Menu bar
• Job Status Helper
• Action buttons
• Active Jobs window
• Jobs window
• Activity Monitor (selected server view)

Style 1* Displays the following Command WorkStation 
components:
• Menu bar
• Job status indicators
• Action buttons
• Active Jobs window

Style 2* Displays the following Command WorkStation 
components:
• Menu bar
• Job status indicators
• Action buttons
• Active Jobs window
• Activity Monitor (all servers view)

Custom 1, Custom 2, or 
Custom 3*

Sets the Command WorkStation window to a custom layout 
previously defined and named using the Save Layout 
command. 

Menu Command Submenu command Description
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Window
(cont.)

Save Layout* Allows you to save and name the current Command 
WorkStation display as a custom layout. Saved layouts 
appear as commands in the Window>Layouts submenu. 
You can save up to three custom layouts. 

Jobs Window Switches the Jobs window (including the Printed Jobs, 
Archive, FreeForm, and Job Log panels) on or off. A check 
mark next to the command indicates that the Printed Jobs 
window is displayed.

Activity Monitor Switches the Activity Monitor on or off. A check mark next 
to the command indicates the Activity Monitor is displayed.

Action Buttons* Switches the Action buttons on or off. A check mark next 
to the command indicates the buttons are displayed.

Job Status Helper* Switches the Job Status Helper on or off. A check mark 
next to the command indicates the helper is displayed.

Tile Preview 
Windows†

Displays active Preview windows in tiled formation so that 
the windows are simultaneously visible.

Cascade Preview 
Windows†

Displays active Preview windows in cascading formation so 
that the windows are stacked with their title bars visible.

Preview– <Job 
Name>*

Activates the open Preview window of the named job. 
This menu option appears for each open Preview window.

<Job Name>† Activates the open Preview window of the named job. 
This menu option appears for each open Preview window.

More Previews...* Opens a Previews window, where you can activate, close, 
cascade, and minimize the open Preview windows.

Help* About Command 
WorkStation*

Displays information about the current version of 
Command WorkStation.

Menu Command Submenu command Description
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Context-sensitive menus

When you select one or more jobs in the Active Jobs or Jobs window, you can display 

context-sensitive menus containing job management commands for selected jobs.

TO DISPLAY A CONTEXT-SENSITIVE MENU

1. Select one or more jobs in the Active Jobs or Jobs window.

For details on how to select jobs, see page 3-7.

2. Right-click the selected job (Command WorkStation), or Control- click the selected job 

(Command WorkStation LE).

When multiple jobs are selected, right-click or Control-click any of the selected jobs.

3. Choose the desired command from the context-sensitive menu.

Preparing to work with Command WorkStation or 
Command WorkStation LE
This section describes the setup and administrative tasks required to begin working 

with Command WorkStation or Command WorkStation LE.

Connecting to the EB-105EX

In Command WorkStation, you can maintain connections to multiple EB-105EX 

servers simultaneously. In Command WorkStation LE, you can maintain a connection 

to one EB-105EX server at a time.

TO CONNECT TO THE EB-105EX

1. Choose Log in/Log out from the Server menu.

The server list appears.

2. Select the EB-105EX from the list of EB-105EX servers you have connected to before. 
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The server list displays the EB-105EX servers you can monitor and manage from 

Command WorkStation or Command WorkStation LE. You can add and remove 

EB-105EX servers from the list of EB-105EX servers you frequently monitor.

Each row in the server list displays the name of a EB-105EX, the name of the copier 

associated with that EB-105EX, and a Login button (represented by a key icon). 

Key icon

Command WorkStation

Key icon

Command WorkStation LE
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3. Click the Login button next to the EB-105EX name to establish the connection. 

4. In Command WorkStation, click the Administrator, Operator, or Guest button, enter 

your password and click Log In. In Command WorkStation LE, enter your password and 

click the administrator, operator, or guest button.

Command WorkStation

Command WorkStation LE
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Printing EB-105EX information pages

Use the Print Pages command to print information about the EB-105EX. The pages 

provide useful reference information for setting up or troubleshooting the EB-105EX.

TO PRINT EB-105EX INFORMATION PAGES

1. In the Active Jobs window, select the EB-105EX for which you want to print 

information pages.

NOTE: To print information pages, you must be logged in to the EB-105EX 

as Administrator.

2. Choose Print Pages from the Server menu.

A dialog box containing the information page options appears.

NOTE: Local Printer options are available in Command WorkStation only.

3. For Command WorkStation, in the Select Printer area, specify where you want to 

print the pages.

Server—The pages you specify are printed to the EB-105EX.

Local Printer—Allows you to print the Archive Log and Queues to any printer 

installed on your Windows computer.

Server options Local Printer options
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4. In the Select Pages area, specify the pages you want to print.

Each set of pages contains specific information about the EB-105EX.

You can print the following pages from the EB-105EX:

PS Test Page/PCL Test Page—Allows you to confirm that the EB-105EX is properly 

connected to the copier, and provides grayscale samples to troubleshoot problems with 

the copier or the EB-105EX. The following settings are among those listed on the 

Test Page: Server Name, Printer Model, date and time the Test Page was printed.

Configuration—Provides the current EB-105EX and copier configuration. This 

page lists general information about the hardware and software configuration of 

the EB-105EX, current settings for all Setup options, information about the 

current calibration, and the network addresses of the EB-105EX. 

Job Log—Lists a log of the last 55 jobs processed or printed. For information on 

the fields in the Job Log and printing it in other forms, see “Using the Job Log” on 

page 3-30.

Font List—Lists all PostScript fonts currently resident on the EB-105EX hard disk.

PCL Font List—Lists all PCL fonts currently resident on the EB-105EX hard disk.

When you select the Local Printer option in Command WorkStation, you can 

print the following pages:

Archive Log—Lists all jobs displayed in the Archive panel.

Queues—Lists all jobs displayed in the Active Jobs window.

5. Click Print.

EB-105EX information pages printed with the Print Pages command appear 

in the EB-105EX Job Log with the user name Operator, even if you logged in 

as Administrator.
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Setting preferences

The Preferences dialog box controls application settings.

TO SET PREFERENCES FOR COMMAND WORKSTATION*

1. Choose Preferences from the Edit menu.

The Preferences dialog box appears.
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2. Specify the following preference settings and click OK to save your settings.

Enable Animation—Enables the display of animated graphics in the Selected Server 

view of the Activity Monitor (see page 2-9).

Autologin—Instructs Command WorkStation to remember the last access level and 

password used to log in to each EB-105EX. When you log in to the EB-105EX again, 

Command WorkStation automatically populates the Login dialog box with the 

previous access level and password.

Temporary path—Specifies the folder where Command WorkStation temporarily stores 

copies of the jobs you edit or change. Change the temporary path by clicking Browse 

and specifying a folder.

Imposition: Units—Specifies the units of measurement used to display attributes, such 

as page sizes and custom sizes, in the Job Properties dialog box and Imposition 

window.

Imposition: Template Path—Specifies the folder where template files for imposition are 

stored for later use. Change the template path by clicking Browse and specifying a 

folder.

Search: Template Paths—Specifies the folder where Find/Search templates are stored 

for later use. Change the template path by clicking Browse and specifying a folder.

TO SET PREFERENCES FOR COMMAND WORKSTATION LE†

1. Choose Preferences from the CWS LE menu.

The Preferences dialog box appears.
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2. Specify the following preference settings and click OK to save your settings.

Show Import Options Dialog—When enabled, this preference setting displays a dialog 

box that allows you to specify the destination queue (Hold or Print) for each job 

imported into Command WorkStation LE.

Use Metric Units—Specifies the units of measurement used by Command WorkStation 

LE to display values that you enter manually in the Job Properties dialog box.

Show Animations—Enables the display of animated graphics in the Activity Monitor 

(see page 2-8).

Managing EB-105EX fonts

The EB-105EX includes a number of built-in printer fonts. You can download 

additional fonts to the EB-105EX using the Manage Font command in Command 

WorkStation. Users on the network can also download fonts to the EB-105EX using 

Fiery Downloader™ (see the Printing Guide). 

NOTE: To manage fonts, you must be logged in to the EB-105EX with Administrator 

privileges.

Downloading fonts, either from Command WorkStation or with Fiery Downloader, 

requires that the Direct connection be published in Setup (see the Configuration 

Guide).

NOTE: You cannot download TrueType fonts. If you use TrueType fonts in Windows, 

you can print them by converting them to Adobe Type 1 fonts. To convert TrueType 

fonts with the Adobe PS printer driver, click the Fonts tab and set up the Font 

Substitution Table, as necessary.

To print a list of fonts currently resident on the EB-105EX, use the Print Pages 

command (see page 2-26). 

TO MANAGE FONTS

1. In the Command WorkStation Active Jobs window, select the connected EB-105EX for 

which you want to manage fonts.

If the Active Jobs window is hidden, choose Active Jobs from the Window menu to 

display it.
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NOTE: To manage fonts, you must be logged in to the EB-105EX with 

Administrator privileges.

2. Choose Manage Fonts from the Server menu.

3. To download additional fonts to the EB-105EX, click Add. For Command WorkStation, 

see the procedure on page 2-32. For Command WorkStation LE, see the procedure on 

page 2-33.

4. To delete a font, select it in the Font List and click Delete. 

Click to update the Font List display

Click to delete font(s)

Locked fonts

Click to download additional fonts

Downloaded fonts
Click to print the Font List

Command WorkStation

Click to delete font

Click to download
additional fonts

Click to print the Font List

Command WorkStation LE
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To select multiple sequential fonts in Command WorkStation, select the first font 

and Shift-click the last font; Ctrl-click to select multiple non-sequential fonts.

NOTE: The printer fonts included with the EB-105EX (built-in fonts) are locked. 

These fonts appear with a lock icon next to the name (Command WorkStation) 

or with “True” in the Locked column (Command WorkStation LE) and cannot 

be deleted.

5. In Command WorkStation, to refresh the Font List, click Update.

6. To print the Font List, click Print (Command WorkStation) or Print List 

(Command WorkStation LE).

TO ADD FONTS IN COMMAND WORKSTATION*

1. In the Select Files to Import dialog box, choose the file types to display from the 

“File of type” menu.

All Known Formats lists all files in supported formats; All Files lists all files.

2. In the Look in menu, browse to the folder containing the font(s) to download.

The Filename field displays the name of the selected file.
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3. Select the font name and click Add.

Navigate to different drives and folders to select fonts to download. 

To select multiple sequential fonts, select the first font and Shift-click the last font. 

Ctrl-click to select multiple non-sequential fonts.

To remove a font from the Files to be imported list, select the font name and 

click Remove.

4. When all the desired fonts appear in the Files to be imported list, click Import.

TO ADD FONTS IN COMMAND WORKSTATION LE†

1. In the Open dialog box, navigate to the folder containing the font(s) you want 

to download.

2. Select the font name and click Open.
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Setting up printing groups
If you have logged in to the EB-105EX with Adminstrator privileges, you can set up 

password-protected printing groups. When a printing group is specified for a job, only 

users with password access to that printing group are permitted to print the job. 

Once you create a printing group, it can be assigned to jobs using either the printer 

driver or the Job Properties dialog box in Command WorkStation. For more 

information, see Appendix A of the Printing Guide.

TO SET UP A PRINTING GROUP

1. Choose Printing Groups from the Server menu.

NOTE: The Printing Groups command is only available if you are logged in to the 

EB-105EX as Adminstrator.

A dialog box containing printing group setup options appears.

2. To create a new printing group, click Create. In the dialog box that appears, enter 

the group name and password information, click Add, and then click OK.

The new group is displayed in the printing group list.

3. To modify an existing printing group, select the group in the list and click Modify. 

Edit the setup options as desired, and click OK.

4. To delete an existing printing group, select the group in the list and click Remove.

5. Click OK to save the printing group settings.
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This chapter describes how to use Command WorkStation and Command 

WorkStation LE to monitor and manage job flow on the EB-105EX. Once you log in 

to the EB-105EX with Operator privileges, you can view jobs held on the EB-105EX 

and issue commands to release the jobs for processing or printing. You can also modify 

job properties, such as FreeForm variable data printing requirements, paper settings, 

finishing options, and other print option settings. After a job has printed successfully, 

you can store it in the job archive and view a record of its activity in the Job Log.

For background information on job flow and job management, see Chapter 1. For 

an introduction to the Command WorkStation and Command WorkStation LE user 

interfaces, see Chapter 2.

NOTE: Unless otherwise specified, information in this chapter applies to both 

Command WorkStation and Command WorkStation LE. Sections that apply 

exclusively to Command WorkStation are denoted by an asterisk (*). Sections that 

apply exclusively to Command WorkStation LE are denoted by a dagger (†). 

In cases where the two applications are nearly identical, only Command WorkStation 

illustrations are shown.

Starting up and logging in
To begin working with Command WorkStation or Command WorkStation LE, start 

the application and log in to the EB-105EX.

TO START COMMAND WORKSTATION*

• Click Start on the Windows taskbar, choose Programs >Fiery, and then choose 

Command WorkStation 4.

When you start Command WorkStation for the first time, the Login Server list does 

not display any EB-105EX servers. For instructions on configuring and adding 

EB-105EX servers to the Login Server list, see the User Software Installation Guide.

Chapter 3:
Using Command 
WorkStation 
and Command 
WorkStation LE
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TO START COMMAND WORKSTATION LE†

1. Open the Command WorkStation LE folder, located inside the Fiery folder in the 

Applications folder on your Mac OS X computer hard disk.

2. Double-click the CWS LE file to start the application.

When you start Command WorkStation LE for the first time, the server list does not 

display any EB-105EX servers. For instructions on configuring and adding EB-105EX 

servers to the server list, see the User Software Installation Guide.

Logging in to the EB-105EX

To establish a connection to the EB-105EX listed in the server list, log in to 

the EB-105EX. 

In Command WorkStation, you can maintain connections to more than one 

EB-105EX at a time. Each EB-105EX connection requires an average of 4MB of 

RAM. The maximum number of simultaneous EB-105EX connections is limited only 

by the amount of RAM available on the system running Command WorkStation. For 

example, if your system has 128MB of RAM and is running Command WorkStation 

exclusively, you can log in to approximately 25 EB-105EX servers at one time.
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TO LOG IN TO THE EB-105EX

1. Choose Log in/Log out from the Server menu.

The server list appears.

2. Click the key icon for the desired EB-105EX.

The EB-105EX must appear in the server list before you can log in to it. A white key 

icon indicates the EB-105EX has never been connected to Command WorkStation or 

Command WorkStation LE.

Key icon

Command WorkStation

Key icon

Command WorkStation LE

Remove button 
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If the EB-105EX is already connected, the color of the key icon indicates the level of 

access granted:

• Purple indicates Administrator access.

• Orange indicates Operator access.

• Cyan indicates Guest access.

The Login dialog box appears.

Command WorkStation

Command WorkStation LE
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3. In Command WorkStation, click the Administrator, Operator, or Guest button, enter 

your password and click Log In. In Command WorkStation LE, enter your password and 

click the administrator, operator, or guest button.

This manual assumes you are logged into the EB-105EX as an Operator. The following 

section discusses the three different access levels in greater detail.

Access levels

The three possible levels of access to Command WorkStation or Command 

WorkStation LE are Administrator, Operator, and Guest. To enable maximum 

password protection, Administrator and Operator passwords must be specified in 

Setup (see the Configuration Guide).

When both Administrator and Operator passwords have been specified, the access 

levels are as follows:

NOTE: In Command WorkStation, a user may be logged in as Administrator on one 

EB-105EX, as Operator on a second EB-105EX, and as Guest on a third EB-105EX. 

In these instances, the levels of access are dependent either on the EB-105EX currently 

selected in the Active Jobs window or on the EB-105EX that holds the currently 

selected job.

Access level Privileges and password requirements

Administrator Has full access to all Command WorkStation and Command 
WorkStation LE functions; Administrator password required. For a 
description of the full range of tasks an administrator can implement, 

see the Configuration Guide.

Operator Has access to all Command WorkStation functions, except Setup, 
font management, reordering job priority, restarting the EB-105EX, 
clearing the EB-105EX disk, and clearing the Job Log. Operator 
password required. 

Guest Can view job status, but cannot make changes to jobs or Setup, and 
cannot access Job Log; no password required.
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By default, no passwords are set on the EB-105EX—in this default state, anyone can 

perform Setup and use all Command WorkStation and Command WorkStation LE 

functions. Until an Administrator password is defined in EB-105EX Setup, you can 

log in to the EB-105EX as an Administrator without entering a password, and are 

given full privileges. 

After the administrator has performed Setup and specified passwords, Command 

WorkStation and Command WorkStation LE user options depend on your login level. 

This manual assumes that you are logged in to the EB-105EX as an Operator.

Logging out

Logging out from the EB-105EX terminates the connection between the EB-105EX 

and Command WorkStation or Command WorkStation LE.

TO LOG OUT FROM A CONNECTED EB-105EX

1. Choose Log in/Log out from the Server menu.

2. Click the Login button for the connected EB-105EX in the server list.

3. In Command WorkStation, click Yes to log out from and disconnect the EB-105EX.

Removing the EB-105EX from the server list

You can clear unused EB-105EX servers from the server list.

TO REMOVE THE EB-105EX FROM THE SERVER LIST

1. Choose Log in/Log out from the Server menu.

2. Select the EB-105EX in the server list.

3. Click the Remove button (trash can icon in Command WorkStation LE) to remove the 

EB-105EX from the list.

The Remove button is available only for disconnected EB-105EX servers. 
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Monitoring jobs
The Active Jobs window and the Printed Jobs panel of the Jobs window provide a 

visual method of monitoring the flow of print jobs through connected servers. In 

Command WorkStation, you can use the server selection menu in the title bar of each 

window to monitor a single EB-105EX or multiple EB-105EX servers at once (see 

page 2-12). You can also sort job lists and customize the job ticket information.

The Active Jobs window displays jobs as they pass through the various stages of 

spooling, holding, processing, and printing. Flag colors indicate the status of each job, 

and job ticket columns provide additional job information. Jobs that contain raster 

data as a result of processing are indicated with a halo around their file icons. 

NOTE: If a job is paused during printing (by issuing the Suspend Printing command), 

the job continues to be marked with a dark green status flag in the Active Jobs window. 

However, the job is displayed as “Paused.”

When a job has completed printing (or has failed to print), it drops from the Active 

Jobs window and is added to the Printed Jobs panel. The Printed Jobs panel displays 

jobs that have printed successfully, along with failed jobs that have dropped from the 

Print queue as a result of an error. A failed job appears highlighted in red; you can 

double-click the job to display a more detailed error report.

Selecting jobs

Selecting a job allows you to apply job management commands (from the Actions 

menu) to it.

TO SELECT A JOB

• In the Active Jobs window or in any panel of the Jobs window, click a job to select it.

To select multiple jobs in Command WorkStation LE, hold down Shift and click 

additional jobs.

NOTE: To select multiple jobs, the jobs must be located in the same window and panel.
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Sorting job displays

You can sort jobs in the Active Jobs or Jobs windows by clicking the job ticket 

column headings.

TO SORT JOBS

• In the Active Jobs or Jobs windows, click the heading for the job ticket column that 

you want to use to sort jobs.

For example, to sort jobs by status, click the Job Status column heading. The window 

sorts jobs according to their status.

To reverse the sorting order, click the column heading again.

Customizing job ticket information

Customize the display of job ticket information in the Active Jobs window and in all 

panels of the Jobs window by rearranging the column headings. You can tighten the 

columns, add new column headings, move columns, and delete column headings.

You can customize job ticket information according to your workflow needs. 

For example, if you are monitoring multiple servers, you can add Fiery and Device 

columns to track the location of individual jobs.

In Command WorkStation, the information in the Date/Time column is based on 

the date and time settings of the Regional Settings control panel. Access the Regional 

Settings control panel from the Start>Settings>Control Panel menu in the 

Windows taskbar.
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TO CUSTOMIZE JOB TICKET INFORMATION FOR THE ACTIVE JOBS 
OR JOBS WINDOWS IN COMMAND WORKSTATION*

1. Right-click the heading of a job ticket column.

2. From the menu that appears, choose the options to display and the sequence 

in which you want to view them.

Add—Adds one of the listed columns to the display at your mouse position. 

The submenu lists the headings that are not displayed.

Move Left, Move Right—Moves the selected column left or right.

Delete—Removes the selected column.

The Job Status (Active Jobs window only), Job Title, and User columns are 

required—all others are optional.

3. Adjust the column widths. 

Adjust the width of a column by clicking the column border in the heading and 

dragging to the left or right. You can change the column widths at any time.

TO CUSTOMIZE JOB TICKET INFORMATION FOR THE ACTIVE JOBS 
OR JOBS WINDOWS IN COMMAND WORKSTATION LE†

1. Control-click the heading of a job ticket column.

2. From the menu that appears, choose Edit Visible Columns.
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3. In the List Editor dialog box, specify the job ticket columns that you want displayed.

To add a column, select the column name in the list on the right and click Add. To 

remove a column, select the column name in the list on the left and click Remove.

4. Click OK to apply your changes.

5. Adjust the placement of columns.

Rearrange the placement of a column by dragging the column to the left or right.

6. Adjust the column widths. 

Adjust the width of a column by clicking the column border in the heading and 

dragging to the left or right. You can change the column widths at any time.

Managing job flow

The following sections describe the job management tasks you can perform with 

Command WorkStation and Command WorkStation LE.

Importing jobs

Use the Import command to import jobs into the job flow. You can import jobs 

located anywhere in the connected network, or jobs previously archived to 

external devices. For more information on archiving jobs, see page 3-28.

TO IMPORT A JOB INTO COMMAND WORKSTATION*

1. Choose Import from the File menu, and then choose Job or Archived Job.

The Select Files to Import dialog box appears.

2. Locate and select the job file to import and click Add.

The job appears in the Files to be imported list. To import multiple jobs, select each 

additional job and click Add.
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3. Choose the desired destination queue from the Logical Printer menu.

A destination queue is available only if the administrator has enabled it in Setup 

(see the Configuration Guide).

If you choose Hold, the job is imported into the Active Jobs window and held for 

future action.

If you choose Print, the job is imported into the Active Jobs window and released for 

immediate printing.

If you choose Direct, the job is sent directly to the EB-105EX for printing. The job 

does not appear in the Active Jobs window or Printed Jobs panel.

4. Click Import.
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TO IMPORT A JOB INTO COMMAND WORKSTATION LE†

1. Choose Import from the File menu, and then choose Job or Archived Job.

2. Locate and select the job file to import and click Open.

3. If the Import Options dialog box appears, specify the desired destination queue,

and then click OK.

Control the display of the Import Options dialog box by specifying the “Always 

show this dialog” option or setting the Show Import Options Dialog preference 

(see page 2-29).

A destination queue is available only if the administrator has enabled it in Setup 

(see the Configuration Guide).

If you choose Hold, the job is imported into the Active Jobs window and held for 

future action.

If you choose Print, the job is imported into the Active Jobs window and released 

for immediate printing.
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If you choose Direct, the job is sent directly to the EB-105EX for printing. The job 

does not appear in the Active Jobs window or Printed Jobs panel.

Using job management commands

When logged in to the EB-105EX as Operator, you can issue the following job 

management commands from the Actions menu to release or hold selected jobs in the 

Active Jobs window and Printed Jobs panel:

• Print 

• Process and Hold 

• Print and Hold 

• Remove Raster Data

• Hold

The availability of each command varies, depending on the context of the selected job. 

In addition to choosing these commands from the Actions menu, you can issue them 

from context-sensitive menus. Activate the Print, Hold, and Process and Hold 

commands using the Action buttons.
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The following table describes job management commands in greater detail and 

explains how each command affects the raster data associated with a job:

Choose this command To do this Raster data is

Print Prints the selected job in the Active Jobs 
window, Printed Jobs panel, FreeForm 
panel, or Archive panel.

Temporarily held on the EB-105EX until 
the job completes printing.

Hold Holds the selected job waiting to process in 
the Active Jobs window, or the selected job 
in the Printed Jobs or Archive panel, and 
marks the job with either the spooled/held 
flag or the processed/held flag.

Held on the EB-105EX hard disk 
indefinitely, if raster data is included 
with job.

Process and Hold Processes the selected job in the Active Jobs 
window, Printed Jobs panel, or Archive 
panel, and holds a copy of the job. The 
copied job is marked with the processed/
held flag.

Held on the EB-105EX hard disk 
indefinitely.

Print and Hold Prints the selected job in the Active Jobs 
window, Printed Jobs panel, or Archive 
panel, and holds a copy of the job. The 
copied job is marked with the processed/
held flag. 

Held on the EB-105EX hard disk 
indefinitely.

Remove Raster Data Removes the raster data associated with the 
selected processed/held job in the Active 
Jobs window, or with the selected raster job 
in the Printed Jobs or Archive panel; leaves 
the original PostScript data in place.

Deleted.
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Viewing and overriding print settings

When logged in as Operator, you can view, override the user print settings, and print 

any held job in the Active Jobs window and the Printed Jobs panel. You can view and 

override print settings of jobs in the FreeForm panel. You can view print settings, and 

print jobs in the Archive panel.

Use the Job Properties dialog box to view the user Notes and Instructions fields 

included with jobs.

NOTE: You cannot override the print option settings of PCL jobs.

TO VIEW AND OVERRIDE PRINT SETTINGS

1. To view and override print settings for a held job, select the job in the Active Jobs 

window or Printed Jobs panel. 

You can also select a job in the Archive or FreeForm panel to view print settings.

2. Choose Properties from the Actions menu.

The Job Properties dialog box appears. This dialog box displays all the job settings 

encoded by the PostScript printer driver that can be decoded by the EB-105EX. If you, 

as the operator, have not changed anything, these are the settings a user entered before 

sending the job.
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The Job Properties dialog box is virtually identical to the Fiery Printing tab of the 

EB-105EX print driver. For more information on the features in the Job Properties 

dialog box, see the online help included with the EB-105EX print driver.

The user Instructions and Notes fields also appear in the Job Properties dialog box.

• Instructions fields are intended to be viewed and annotated by the operator, but 

their contents are associated with the job and are deleted when the job is deleted 

after printing.

• Notes fields can be viewed but not changed by the operator; their contents are 

transcribed to the Job Log just as the user sent them.

Command WorkStation

Command WorkStation LE
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NOTE: Some print options available in the printer driver are not displayed in the Job 

Properties dialog box. For information on specific print options and settings, and 

where they can be set, see Appendix A of the Printing Guide.

3. To override a setting, expand the blue bar for that print setting category and specify 

the desired setting.

NOTE: To retain a copy of the job with its original settings, duplicate the job and 

rename the duplicate before you change any settings. 

NOTE: For some options, changing the setting requires that the job be reRIPped; these 

options appear with an icon to the left of the option name.

Indicates reRIPping is required

Command WorkStation
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4. In Command WorkStation, to print the current list of print settings on a local printer, 

click Print Properties.

5. To apply the print setting overrides to the selected job, click OK.

Indicates reRIPping is required

Command WorkStation LE
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Reordering jobs*

If you are logged in to Command WorkStation as an Administrator, you can reorder 

the priority of jobs that are waiting to process or print.

TO REORDER JOB PRIORITY

1. In Command WorkStation, choose Reorder Jobs from the Server menu.

2. Click the tab corresponding to the jobs that you want to reorder.

You can reorder either jobs that are waiting to process or jobs that are waiting to print.

3. Select the desired job in the list, and click the buttons on the right of the dialog box 

to reorder the job’s priority.

4. Click Done when you are finished reordering the job priority.

Move to highest priority

Move up in priority

Move down in priority

Move to lowest priority
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Managing jobs on multiple EB-105EX servers*

Command WorkStation allows you to simultaneously connect to as many EB-105EX 

servers as your RAM resources allow. You can view and manage jobs processed by 

multiple EB-105EX servers from a single location and balance the job load between 

servers of similar capabilities.

NOTE: You can connect to any Fiery server that is supported by Command 

WorkStation.

• If you connect to multiple servers from Command WorkStation, you can easily 

switch between the All Servers view and the Selected Server view in the Active Jobs 

window, Jobs window, and Activity monitor. For more information, see 

“Monitoring single or multiple EB-105EX servers*” on page 2-12.

• With servers that support the feature, use the “Send to” command to transfer jobs 

between servers. 

For example, by viewing print jobs on all connected servers in the Active Jobs window, 

you can monitor the print load on each EB-105EX in your printing environment. If 

one EB-105EX has received a disproportionate number of jobs, you can balance the 

load by transferring some of these jobs to another, less active EB-105EX. 

TO TRANSFER A JOB BETWEEN SERVERS

1. In the Active Jobs window, select any held job. 

2. Choose Send To from the Actions menu and select the EB-105EX that you want to send 

the job to. 

3. Click Yes to confirm the transfer of the job.



33-21 Defining Mixed Media settings*

Canceling jobs

You may need to cancel a job after it has been routed for processing or printing. 

You can cancel a selected job only while it is being processed or printed. You cannot 

cancel a job that is waiting to be processed or printed. 

• Canceling jobs during processing—While a job is processing in the Active Jobs 

window, select the job and choose Cancel Processing from the Actions menu. 

The name of the canceled job is displayed in the Job Log.

• Canceling jobs during printing—While a job is printing in the Active Jobs window, 

select the job and choose Cancel Printing from the Actions menu. 

The name of the canceled job is displayed in the Job Log. 

NOTE: Canceled jobs may be partially printed, and may include pages with one or more 

missing color plates, or pages that are completely blank.

• Pausing all jobs on the EB-105EX—Choose Suspend Printing from the Server menu 

to suspend the printing of all jobs on the EB-105EX. To continue printing jobs, 

choose Resume Printing from the Server menu.

Defining Mixed Media settings*
The Mixed Media feature allows you to define chapter divisions for a job, print ranges 

of pages on different weights of media, or insert blank media between pages. For more 

information, see the Printing Guide.

NOTE: Inserted blank media between pages are not charged as printed pages. 



33-22 Using Command WorkStation and Command WorkStation LE

TO DEFINE MIXED MEDIA SPECIFICATIONS*

1. In Command WorkStation, select a spooled/held job in the Active Jobs window, and 

choose Mixed Media Setup from the Actions menu.

The Mixed Media dialog box appears. This dialog box lists any previously defined 

media settings and includes buttons for adding, modifying, and deleting settings.

2. In the Page Range field, enter page numbers or page ranges that are to be printed on a 

distinct type of media. 

Separate page numbers and page ranges by commas (for example: 3,9–14,18).To insert 

a blank page, enter a caret symbol before a page value (for example: 2,^7,9–16).

3. Choose the desired media for the specified page range from the Media Type menu.

To print pages on tab paper stock, choose True from the Tabs in Page Range(s) menu, 

and then choose Tab Stock from the Media Type menu. By default, tab printing is set 

to False.

4. Choose the desired duplexing option for the page range from the Duplex menu.

By default, duplexing is set to Off.
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5. Choose the source tray containing the specified media type from the Input Tray menu.

6. Click Add to add the media specification to the Selection List. To remove a mixed 

media specification, select it and click Remove.

Define and add more mixed media specifications as needed. Page ranges not specified 

as mixed media print on the media you defined in the Paper Source settings.

7. In the Chapter Start field, enter the page numbers on which to start new chapters.

Separate page numbers by commas (for example: 4,9,17) to indicate the start of each 

new chapter. This feature forces each chapter to start on the right, adding a blank left 

page, if necessary, in front of a new chapter. 

NOTE: You do not need to enter the first page, and page numbers refer to the 

numbering of the original document. If you use the Chapter Start feature, all media 

specified in the Paper menu must share the same dimensions per chapter (for example: 

all Letter, all Tabloid, or all A4).

8. To apply finishing options (for example, stapling or sorting) to each chapter you 

create using the Chapter Start feature, select “Define each chapter as a separate 

finishing set.”

9. Click OK.

The Job Properties dialog box appears.

10. If you specified that certain page ranges be printed on tab paper stock, click 

Paper Source in the Job Properties dialog box, and select the Tabs in Page Range(s) 

option in the Mixed Media area.

11. Click OK to close the Job Properties dialog box and apply the Mixed Media settings to 

the job.



33-24 Using Command WorkStation and Command WorkStation LE

Printing FreeForm variable data documents

The FreeForm printing feature provides a flexible and efficient method of printing 

variable data jobs (such as direct-mail advertising pieces). FreeForm allows users to 

preRIP and store the master elements of their variable data jobs on the EB-105EX, and 

then use that master data as needed, for multiple variable data jobs. 

The preRIPped master-element jobs are stored on the EB-105EX as FreeForm masters, 

and appear in the FreeForm panel of the Jobs window.

The ability to override job settings is especially important for variable data printing 

with FreeForm. Although the EB-105EX can store up to 100 FreeForm masters, users 

are limited to a range of 1 to 15 values that they can specify for the Create Master and 

Use Master print settings. To make use of all 100 available FreeForm Masters, the 

operator must override the Create Master and Use Master print settings from 

Command WorkStation or Command WorkStation LE.

For any new Create Master or Use Master setting to take effect, the job must be 

reRIPped.

For background information on using the FreeForm feature, see the

Printing Guide.

Creating and monitoring FreeForm masters

Users assign FreeForm master numbers from 1 to 15 using the Create Master 

print option when they send a job. These numbers can be changed to a master number 

from 1 to 100, with job overrides from the Job Properties dialog box.
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When the first 15 FreeForm master numbers have been used, users may inadvertently 

overwrite existing FreeForm masters by assigning what they think are new, unused 

FreeForm master numbers. When users choose a master number from the Create 

Master print option, an existing job using that master number is overwritten (the user 

receives a warning message that they are about to replace an existing job). 

For this reason, the operator should delete existing master jobs or reassign master 

numbers 1 through 15 to avoid any overwriting problems. Only the operator can 

assign numbers from 16 to 100, enabling a high level of control over the FreeForm 

master numbers in use.

TO CREATE A FREEFORM MASTER

1. In the Active Jobs window, select the held job comprising the master elements of 

the document.

2. Choose Properties from the Actions menu.

3. Scroll to FreeForm in the Job Properties dialog box.

4. For the Create Master print setting, specify the FreeForm master number you want to 

assign to the job.

5. Click OK.

6. Choose Process and Hold from the Actions menu to assign the job a destination.

Choose Print or Print and Hold from the Actions menu to generate a hard copy of the 

FreeForm master.

After processing, the master job appears in the FreeForm panel of the Jobs window.

TO DELETE A FREEFORM MASTER

1. In the FreeForm panel, select the master job to delete.

2. Choose Delete from the Actions menu.
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Using FreeForm masters with variable data jobs

To print a variable data job with a particular FreeForm master, users must specify a 

number for the Use Master print setting. Users can only specify master numbers 

between 1 and 15. Only the operator can specify master numbers between 16 and 100, 

with job overrides from the Job Properties dialog box.

TO OVERRIDE THE USE MASTER PRINT SETTING

1. In the Active Jobs window, select the held job comprising the variable elements of the 

document, and choose Properties from the Actions menu.

2. Scroll to FreeForm in the Job Properties dialog box.

3. For the Use Master print setting, specify the FreeForm master job to use as the 

master document.

4. Click OK.

5. Choose Process and Hold, Print, or Print and Hold from the Actions menu to assign 

the job a destination.

Particularly with a variable data job, Process and Hold the job so you can preview it 

before printing.
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Tips for using FreeForm

At sites where a small number of users print FreeForm jobs, the operator may want to 

assign FreeForm master numbers to specific users, then let them monitor their own 

master numbers. Users can choose the Create Master print option to assign new 

masters or overwrite existing masters. They can also instruct the operator to reassign 

master numbers (to a number greater than 15) for FreeForm masters they want 

available on the EB-105EX.

At sites where a large number of users print FreeForm jobs, the operator may want to 

instruct users not to use the Create Master print option at all, but rather to send all 

their jobs to the Hold queue. In this case, the operator decides which FreeForm master 

numbers to assign before printing.

For all jobs sent to the EB-105EX, users should specify information (such as the 

desired FreeForm master number) to the operator using the Notes and Instructions 

fields in the Printer Job Notes dialog box. 

NOTE: When specifying additional print settings for FreeForm jobs, certain print 

option settings must match for both the master and the variable job. Also, certain 

settings in the variable job override corresponding settings in the master job. For 

complete information on print settings in FreeForm jobs, see the Printing Guide.
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Archiving jobs

You can archive PostScript and raster data jobs internally to the EB-105EX hard disk, 

or externally to the Command WorkStation or Command WorkStation LE hard disk 

or network drives. Once a PostScript or raster data job is archived, it appears in the 

Archive panel of the Jobs window.

You can issue the following Actions menu commands, described on page 2-15, for jobs 

in the Archive panel:

• Print

• Delete

• Rename

• Hold

• Process and Hold

• Print and Hold

• Remove Raster Data

• Properties

TO ARCHIVE A JOB

1. In the Active Jobs window, select any held job.

2. Choose Archive from the Actions menu.

3. To archive the job internally to the EB-105EX hard disk, click OK.

The job is archived internally and appears in the Archive panel of the Jobs window.
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4. To archive the job externally to the Command WorkStation or Command WorkStation LE 

hard disk or to a device on the network, click Add.

5. Browse to the device and folder to which you want to archive the job and click OK 

(Command WorkStation) or Choose (Command WorkStation LE).

The Archive Options dialog box displays external devices as available archive volumes.

6. In Command WorkStation, if applicable, select Archive rasters in the Archive Options 

dialog box.

The Archive rasters option is not available for PostScript data jobs and jobs archived to 

Server Internal.

NOTE: Large raster data files may take considerable time to archive.

7. Select an archive volume and click OK.

Archived jobs appear in the Archive panel of the Jobs window.

Click to add a device
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Using the Job Log
The Job Log panel of the Jobs window displays a list of all the jobs processed or printed 

since the Job Log was last cleared. 

You can adjust the column widths in the Job Log display by clicking the column 

border in the heading and dragging left or right (see “Customizing job ticket 

information” on page 3-8). You can also print the Job Log, export it to a tab-delimited 

text file, or clear it manually.

Using the Job Log Setup, the administrator can specify preferences to print the Job Log 

automatically every 55 jobs, or print and clear the Job Log automatically every 55 jobs. 

Periodically clearing the Job Log can help improve the performance of the EB-105EX. 

The administrator can also choose the Job Log page size. For more information, see the 

Configuration Guide.

NOTE: If a job was saved from the Imposition window of DocBuilder Pro with a new 

name and then printed, it appears in the Job Log with the name of the original job, 

not the new name.

TO PRINT THE JOB LOG FROM COMMAND WORKSTATION 
ON A LOCAL PRINTER*

1. In Command WorkStation, choose Print from the File menu, and then choose Job Log.

The Print dialog box appears.

2. Specify your local printer settings and click OK. 
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TO EXPORT THE JOB LOG

1. If it is not already displayed, click the Job Log tab on the Jobs window to open the 

Job Log panel.

2. Click inside the Job Log panel to make it active.

3. In Command WorkStation, choose Job Log from the Server menu, and then choose 

Export. In Command WorkStation LE, choose Export from the File menu, and then 

choose Job Log.

4. Rename the file, if desired (the default name is job.log), specify a destination, and 

then click Save.

The Job Log is exported to a tab-delimited text file. You can open the exported file 

using a spreadsheet, database, or word processing application.

TO CLEAR THE JOB LOG

• In Command WorkStation, choose Job Log from the Server menu and then choose 

Export and Clear. In Command WorkStation LE, choose Clear Job Log from the 

Server menu.

NOTE: You can clear the job log only if you are logged in to the EB-105EX with 

Administrator privileges.

Searching for jobs
The Find command allows you to search for and locate jobs on connected servers, 

using search parameters such as job file names or dates of creation. Use the Find 

command to search for jobs that appear in the Active Jobs window and in the Printed 

Jobs, Archive, FreeForm, and Job Log panels of the Jobs window.

In Command WorkStation, you can perform advanced searches based on the file sizes 

and specific print options associated with jobs. You can save any set of general or 

advanced search parameters as a Find template, which you can reuse to perform the 

search again.
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TO SEARCH FOR JOBS

1. Choose Find from the Edit menu.

The Find dialog box appears.

2. In Command WorkStation, choose a specific EB-105EX or all EB-105EX servers from 

the Search Server list.

3. Select one or more areas where you want to search for jobs.

You can search for jobs in the Active Jobs window and in the Printed Jobs, Archive, 

FreeForm, and Job Log panels of the Jobs window.

4. Click the General tab, and specify parameters for the search.

NOTE: To clear all fields in the Find dialog box at any time, click New Search 

(Command WorkStation) or New Find (Command WorkStation LE).

You can specify any or all of the following general search parameters. Available search 

parameters vary, depending on the areas selected for the search.

Job title—Enter the file name of the job.

User—Enter the name of the user who sent the job.

Notes 1, Notes 2—Enter text that appears in the Notes fields of the job.

Instructions—Enter text that appears in the Instructions field of the job.

Volume*—Specify the archive drive volume you want to search. This option is 

available only when you are searching for archived jobs.

Date created*—To search through all jobs, regardless of their creation date, select All. 

To restrict your search to jobs created on a certain date or range of dates, select Range. 

Use the From and To menus to specify start and end dates.

5. Click Search (Command WorkStation) or Find (Command WorkStation LE) to find the 

jobs that meet the specified search criteria.

The Search Results window (Command WorkStation) or the Find dialog box 

(Command WorkStation LE) lists found jobs. 

In Command WorkStation, you can customize the appearance of the Search Results 

window in the same manner as the Active Jobs and Jobs windows. For example, you 

can display jobs on all connected EB-105EX servers or on a selected EB-105EX (see 

page 2-12). You can also customize job ticket information (see page 3-8). 
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In Command WorkStation LE, you can customize the display of found jobs by resizing 

or rearranging the job ticket columns (see page 3-9).

TO PERFORM AN ADVANCED SEARCH FOR JOBS*

NOTE: The Advanced search feature is available for Command WorkStation only.

1. Choose Find from the Edit menu.

The Find dialog box appears.

2. Choose an option from the Search Server menu to search for jobs on a specific 

EB-105EX, or all connected EB-105EX servers.

3. Select one or more areas to search for jobs.

Search for jobs in the Active Jobs window and in the Printed Jobs, Archive, FreeForm, 

and Job Log panels of the Jobs window.

4. Click the Advanced tab.

The Advanced tab of the Find dialog box includes an area for specifying file size search 

parameters. The Advanced tab also contains a list of all the print options associated 

with jobs on the server or servers specified by the Search Server setting.

To search for jobs that fall within a particular range of file sizes, choose a range option 

from the Size (kilobytes) menu. Enter the range values in one or both of the fields. 

To search for jobs that have certain print options, click the selection box for each 

desired print option in the list. 

To specify additional search values for a selected option, right-click the field next to the 

option name and enter the desired values.

If you select multiple print options, Command WorkStation searches for jobs that 

include all the selected options. For example, if you specify a stapling and a punching 

option for your search, Command WorkStation only finds jobs that have both stapling 

and punching specified. 

To clear all fields in the Find dialog box at any time, click New Search.

5. Click Search to find the jobs that meet the specified search criteria.

The Search Results window lists the found jobs. 
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TO SAVE THE CURRENT SET OF SEARCH PARAMETERS AS A FIND TEMPLATE

1. In the Find dialog box, specify the desired search parameters, as described in 

previous procedures.

2. Click Save As.

A dialog box appears, prompting you to name the template.

3. Enter a name for the new Find template and click OK.

Saved templates appear in the Queries menu. To remove a template from the menu, 

select the template and click Delete.

In Command WorkStation, saved templates are stored in the folder location you 

specified in the Preferences dialog box (see page 2-28).

TO REUSE A FIND TEMPLATE

1. In the Find dialog box, choose the desired template from the Queries menu.

The dialog box is automatically populated by the search parameters associated with 

the template.

2. Click Search (Command WorkStation) or Find (Command WorkStation LE) to begin 

searching for jobs.
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The Preview windows of Command WorkStation and Command WorkStation LE 

allow you to display preview images of jobs and perform edits, such as adding, 

deleting, duplicating, and reordering pages. You can also merge pages from two 

different jobs into a single, merged job.

NOTE: The DocBuilder Pro option allows you to use additional preview and edit 

features. For more information, see page 5-1.

NOTE: Unless otherwise specified, information in this chapter applies to both 

Command WorkStation and Command WorkStation LE. In cases where the two 

applications are nearly identical, only Command WorkStation illustrations are shown.

Previewing jobs
Use the Preview windows to preview pages of selected jobs. 

Displaying thumbnail previews

When you select a job and choose Preview from the Actions menu, a preview window 

opens, displaying thumbnail images of the selected job.

TO VIEW THUMBNAILS OF A JOB

1. In Command WorkStation, select a processed/held job in the Active Jobs window, or 

select a FreeForm master job in the FreeForm panel. In Command WorkStation LE, 

select a spooled/held or processed/held job in the Active Jobs window.

2. Choose Preview from the Actions menu.

Page thumbnails appear in the Preview window.

Chapter 4:
Previewing and 
Manipulating 
Jobs
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Preview window controls

The following illustrations show the various controls (represented by icons) that are 

available in the Preview window. Each control is described in more detail elsewhere in 

this chapter.

Displaying full-screen previews

You can open a selected page in the Preview window as a full-screen image for a more 

detailed inspection. 

NOTE: Full-screen previews are not supported for FreeForm jobs.

Command WorkStation

Full-screen Preview 

Duplicate 

Delete

Undo

Save 

Command WorkStation LE

Full-screen Preview 

Duplicate 

Undo

Redo

Save 

Delete 
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TO VIEW A FULL-SCREEN PREVIEW OF A JOB

• Select a page in the Preview window and click the Full-Screen Preview control 

(see page 4-2).

NOTE: The full-screen preview may take a few moments to open. The full-screen 

preview window is independent of Command WorkStation or Command 

WorkStation LE and may appear behind the application on the screen. 

Bring the full-screen preview window to the front, if necessary.

Previous Page

Rotate (90, 180,
or 270 degrees)

Thumbnail

Command WorkStation

Next Page
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Use the controls in the full-screen preview (represented by icons) to change the 

zoom level, rotate the page, display other pages, or return to the thumbnail preview. 

Scroll bar (to view other pages)

Rotate (90, 180, or 270 degrees)

Next Page

Thumbnail

Command WorkStation LE

Zoom In

Zoom Out Previous Page
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Editing and merging jobs
Use the Preview windows to reorder and edit the pages of a job, or merge pages from 

several jobs into a single job.

Editing jobs

The Preview window includes controls that allow you to make page-level edits to a job.

TO EDIT A JOB

1. In Command WorkStation, select a processed/held job in the Active Jobs window, or 

select a FreeForm master job in the FreeForm panel. In Command WorkStation LE, 

select a spooled/held or processed/held job in the Active Jobs window.

The Preview window opens, displaying thumbnails of the pages in the job. 

2. Select the pages you want to edit.

Shift-click to select multiple, sequential pages; Ctrl-click (Command WorkStation) 

or Command-click (Command WorkStation LE) to select multiple, non-sequential 

pages.

3. Apply the desired edits.

To apply edits to the selected page, click any of the controls that appear under the 

title bar of the Preview window (for an illustration, see page 4-2):

Full-screen Preview—Opens a full-screen preview of the selected page (see page 4-2). 

The full-screen preview allows you to rotate the selected page.

Duplicate—Duplicates the selected page.

Delete—Deletes the currently selected page. 

Undo—Reverses recently performed edits.

Redo—Reapplies recently performed edits. This control is available for Command 

WorkStation LE only.

4. To move pages within the Preview window, click to select the pages, and hold down the 

mouse button as you drag the selected pages to the new location.

Shift-click to select multiple, sequential pages; Ctrl-click (Command WorkStation) or 

Command-click (Command WorkStation LE) to select multiple, non-sequential 

pages. Release the Shift, Command, or Ctrl key before moving the pages.
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In Command WorkStation LE, a blue vertical line indicates the destined location of 

the page you are dragging.

In Command WorkStation, the following icons indicate the result of your action. If 

the icon does not have an arrow, existing pages are overwritten and replaced by dragged 

pages; if the icon has an arrow, the dragged pages are inserted.

5. When you finish making edits, click the Save control (see page 4-2) to save the job.

6. Enter a new name for the editing job and click Yes (Command WorkStation) or Save 

(Command WorkStation LE).

…

…

Replace single page Replace multiple pages

Move single page Move multiple pages
between two pages between two pages

…

Move single page Move multiple pages
before first page before first page

…

Move single page Move multiple pages
after last page after last page



44-7 Editing and merging jobs

Merging jobs

Merging allows you to combine documents from different sources into a single file. For 

example, you can combine covers and chapter head pages created in a page layout 

application with text pages created in a word processing application. Or, you can 

customize a slide presentation by inserting slides from a different presentation. 

To merge pages from two different jobs, both jobs must reside on the same EB-105EX.

NOTE: When printing a merged job, Command WorkStation or Command 

WorkStation LE generally gives priority to the print settings of the original jobs over 

those of the merged job. Before merging two jobs, make sure that both jobs have been 

processed using the common print settings desired for final output. For example, to 

create a merged job that prints to duplexed pages, make sure both original jobs have 

been processed with the duplex setting enabled. Overriding the print settings of a 

merged job can produce unexpected results and is not recommended. 
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TO MERGE PAGES FROM TWO DIFFERENT JOBS

1. Select a job and choose Preview from the Actions menu.

2. Select another job and choose Preview from the Actions menu.

The job is displayed in another Preview window.

NOTE: To merge pages, both jobs must reside on the same EB-105EX.

3. In the source document Preview window, click to select the pages, and hold down the 

mouse button as you drag the selected pages to the new location in the destination 

document Preview window.

Shift-click to select multiple, sequential pages; Ctrl-click (Command WorkStation) or 

Command-click (Command WorkStation LE) to select multiple, non-sequential 

pages. Release the Shift, Command, or Ctrl key before moving the pages.

To replace pages, drag the second preview pages on top of pages in the first Preview 

window; to add pages, drag the pages to a new position between pages, before the first 

page, or after the last page in the first Preview window.

Source document preview

Destination document preview
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Moving the selection over an existing page replaces the existing page with the one you 

are moving. Moving the selection to the left or right of a page places the selection in 

that location and renumbers the pages. 

In Command WorkStation LE, a blue vertical line indicates the intended location 

of the selection you are dragging. In Command WorkStation, the cursor changes to 

reflect the result of your action:

Multiple levels of undo are available; use the Undo control to undo all the way back to 

your first edit. There is a Redo control available for Command WorkStation LE only 

(see page 4-2).

NOTE: After you drag pages from one Preview window to the other, the first window is 

designated as the source, and the other window the destination. During a merging 

session, you can drag pages only from the source window to the destination window, 

not vice versa. To merge pages in the opposite direction, you must save your current 

changes to the destination window and begin a new merging session.

…

…

Replace single page Replace multiple pages

Move single page Move multiple pages
between two pages between two pages

…

Move single page Move multiple pages
before first page before first page

…

Move single page Move multiple pages
after last page after last page

+

+

+

+ + +

+ +

+ +

+ +
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4. To merge additional pages from another source job, open a new job (resident on the 

same EB-105EX) in a Preview window. 

Repeat step 3 to merge pages from the new source job.

5. When you have finished merging pages, click the Save control (see page 4-2).

6. Enter a new name for the merged job, and click Yes (Command WorkStation) or Save 

(Command WorkStation LE).

NOTE: When multiple users are connected to the EB-105EX via a job management 

utility, only one user should make changes at a time. If multiple users make changes in 

the same job simultaneously, unexpected results may occur.
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The DocBuilder Pro option allows you to apply imposition layouts to jobs for special 

printing and binding needs. DocBuilder Pro also provides several enhancements to 

the previewing, editing, and merging features of Command WorkStation. 

For background information on using imposition, see Appendix A. For information 

on customizing imposition settings, see Chapter 6.

NOTE: DocBuilder Pro is available as an optional upgrade for Command WorkStation. 

For more information, contact your authorized service/support technician.

Previewing, editing, and merging jobs
With the DocBuilder Pro option, you can use the Preview windows of Command 

WorkStation to preview, edit, and merge PostScript and PDF jobs that have been 

spooled and held. You can apply all of the features discussed in Chapter 4 to 

spooled/held jobs and processed/held jobs. 

Detailed descriptions of the DocBuilder Pro enhancements to the Preview windows 

follow. When applicable, page number references to sections in other chapters are 

provided.

Previewing jobs—You can select any PostScript or PDF job showing a spooled/held 

(light yellow) status, and open the job in a Preview window (see page 4-1). 

When you preview a PostScript job, Adobe Acrobat automatically opens in the 

background, generating PDF thumbnails that allow you to preview the job and 

perform further edits, including merging. A message prompts you to accept conversion 

of the file to PDF.

Chapter 5:
Using 
DocBuilder Pro
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When you open the full-screen preview for a spooled/held PostScript or PDF job, you 

have access to three additional preview controls, as follows.

Editing page content—Edit the contents of a spooled/held page by opening its 

full-screen preview (see page 4-2), and using the Adobe Acrobat and Enfocus PitStop 

editing tools (see page 6-21).

Merging jobs—Merge pages from several spooled/held jobs together in a new file 

(see page 4-7). To merge jobs, both jobs must have the same status; that is, both jobs 

must be spooled/held or processed/held.

Inserting blank pages—Insert blank pages into a spooled/held PostScript or PDF job. 

First, open the job in a Preview window. Right-click a page thumbnail, and choose 

Blank Page from the menu. A blank page is inserted after the currently selected page.

Move preview around in window

Click to edit page content

Magnify preview
(hold down Ctrl to zoom out)
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Imposition window
From the Imposition window, you can impose the pages of a document in an order 

and placement suitable for printing and binding. If you are connected to more than 

one server, you can access the Imposition feature from one server only.

TO OPEN A JOB IN THE IMPOSITION WINDOW

1. Send the job you want to impose to the Hold queue.

For information on using Command WorkStation, see Chapters 2 and 3.

2. Select any spooled/held job in the Active Jobs window, and choose Impose from the 

Actions menu. You can also right-click the job and choose Impose from the menu that 

appears.

You can open a PostScript or PDF (Portable Document Format) file, but it must show 

a spooled/held job status.

NOTE: If you have installed the DocBuilder Pro option, you must install a dongle on 

your workstation. If the dongle is not attached, an error message appears. For more 

information, contact your authorized service/support technician.

To impose a processed/held job, select the job in the Active Jobs window and choose 

Remove Raster Data from the Actions menu to put the job in a spooled/held status. 

Choose Impose from the Actions menu. To impose a printed job, select the job in the 

Printed Jobs window and choose Hold from the Actions menu. 

When you choose the Impose command, a page-imaging process generates a PDF 

version of the job on which DocBuilder Pro performs imposition.

A status window appears while the job is imaged for the Imposition window. 
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When it opens, the Imposition window displays the job. No layout is applied unless 

the job has been previously imposed. Templates for common layouts are provided and 

can be invoked from the Imposition window, as described in “Using templates” on 

page 5-9.

Job previews
The Imposition window provides a preview of a job’s pages, allowing you to 

manipulate the source PDF.

Pages appear as a printer’s spread; that is, they appear in the order in which they are 

printed as an imposed job. In contrast, a reader’s spread shows pages in the order they 

are intended to be read. Note that the Preview windows in Command WorkStation 

image jobs as reader’s spreads. 

The paper used to print a printer’s spread is known as a sheet. In duplex printing, each 

sheet has two imageable surfaces—one on the front side and one on the back side of 

the sheet. Each imageable surface contains one printer’s spread.

Printer’s spread

Reader’s spread
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Navigating in the Imposition window

Use the icons and menus at the top and bottom of the Imposition window to perform 

the following:

• Switch from Preview mode (thumbnails of actual content) to Layout mode 

(page numbers only).

• Switch between Mixed Page mode (document with varying page sizes) and Fixed 

Page mode (document with a single page size). For more information on Mixed Page 

and Fixed Page modes, see page 6-1.

• Zoom in and out.

• Drag the job preview around to make a particular page or sheet surface visible.

• Go directly to a particular page or sheet surface.

The Zoom tool, Pan tool, Preview mode, Layout mode, Mixed Page mode, and Fixed 

Page mode buttons are located in the upper-right corner of the window. 

Selecting the Pan or Zoom tool changes the appearance of the cursor to indicate you 

can use that tool to manipulate the preview. When you choose Preview or Layout 

mode, or Mixed Page or Fixed Page mode, a blue border appears around the selected 

view, and the appearance of the job in the Imposition window changes immediately.

Imposition settings appear grouped in the Sheet, Layout, Scale, and Finishing panes at 

the left of the window. To expand or collapse a pane of settings, click the bar for 

that pane.

The Surface menu, View menu, and scroll bar appear at the bottom of the window. 

These menus and controls affect the display in the Imposition window immediately. 
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Switching between page view and layout view

Use the view mode buttons to switch between a page view and a layout view of the job. 

• Preview mode—approximates the appearance of the final printed output very 

closely; for this reason, it is sometimes called a WYSIWYG (“what you see is what 

you get”) preview.

• Layout mode—displays numbered, generic pages that allow you to determine the 

location of source document pages in the imposed job; you can rotate individual 

pages or signatures in a layout view. 

Different viewing modes may display different sets of printer’s marks; for more 

information, see the following table.

NOTE: Preview mode puts more stress on your system’s processor than Layout mode. 

You can improve performance on slower systems by doing most of your work in 

Layout mode, switching to Preview mode only when you need to see content. 

In Layout mode, you can rotate individual pages on the sheet. For more information, 

see “Rotating pages” on page 6-22.

The following table summarizes the characteristics of the Layout and Preview modes: 

Feature Layout mode Preview mode

Shows page content No WYSIWYG content view 

Quick redraw on slower computers Yes No

Shows printer’s marks Yes Yes

Enable/disable printer’s marks Yes Yes

Reorder pages Yes No

Rotate pages Yes No

Define gutter Yes No
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Setting magnification levels

Use the Zoom tool to increase or decrease the level of magnification in the Imposition 

window from 12% to 800%. 

The View menu at the bottom of the window provides several ways to set the level of 

magnification to display the contents of the window. The View menu allows you to 

choose preset zoom values ranging from 50% to 800%. You can also choose to make 

the current preview fit in the window. In addition to preset zoom percents, you can 

specify a custom zoom value. 

TO USE THE ZOOM TOOL

1. Click the Zoom tool to select it. 

The cursor changes to a magnifying glass in the preview area of the Imposition 

window.

2. Position the magnifying glass cursor over a page and click to zoom in.

The magnifying glass cursor displays a plus sign (+) to indicate increased magnification 

of page views. Each time you click, the current magnification doubles, up to a 

maximum of 800%.

3. Hold the Ctrl key and click to zoom out. 

Each time you click, the current magnification is reduced in half, down to a minimum 

of 12%.

4. Right-click the page in the Imposition window.

Select Zoom In or Zoom Out from the menu that appears. Zoom In doubles the 

current magnification; Zoom Out reduces the current magnification by half.

TO USE THE VIEW MENU

• Click the View menu and choose a zoom percent. 

To preview the entire surface, click the View menu and choose Fit Page.

NOTE: The View menu changes only the appearance of pages, not their actual content. 

To change the scaling of pages in finished output, change the Scale area settings.



55-8 Using DocBuilder Pro

TO SPECIFY A CUSTOM ZOOM VALUE

1. Click the View menu at the bottom of the Imposition window.

The current zoom value appears in Zoom dialog box. 

2. Specify a new zoom value.

Enter a new zoom value or select a value from the menu.

3. Click OK or press Enter to confirm the new value. 

The window reflects the change immediately. 

Viewing the sheets

Use the Pan tool to drag the entire preview around in the window. For example, if you 

are working with many pages on a large sheet, use this tool to drag a particular portion 

of the sheet into view. 

At the bottom of the window, you can manipulate the content view using a standard 

scroll bar or the Surface menu. The Surface menu opens the Go To Surface dialog box, 

which allows you to specify numerically the surface to display in the preview area. 

TO USE THE PAN TOOL

1. Click the Pan tool to select it.

The cursor changes to a hand in the Preview area of the window. 

2. With the Pan tool cursor positioned over a sheet, click and hold the left mouse button 

while moving the mouse.

The page preview moves in the same direction as the cursor. Repeat this step as 

necessary to make a particular portion of the preview visible. 
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TO USE THE SURFACE MENU

1. Click the Surface menu at the bottom of the window.

When the Go To Surface dialog box appears, the entry box indicates the number of the 

sheet surface currently displayed.

2. Enter the number of the sheet surface to display.

3. Click OK or press Enter to go to the specified sheet surface.

Using templates
A saved group of imposition settings is known as a template. A template saves all 

current imposition settings, except custom rotations of individual pages on a finished 

sheet and the page size setting. You can apply any template to any job, making it easy 

to apply layout and printing settings quickly and efficiently. 

DocBuilder Pro supplies built-in templates that define settings for commonly used 

layouts, such as 2-Up Saddle, 3-Up Trifold Brochure, 4-Up Gatefold, and so on. 

You can also create your own templates. For a complete listing of built-in templates, 

see Appendix B. For information on creating your own templates, see “Managing 

templates” on page 6-24.

Both built-in templates and your own custom templates appear in the Template menu. 

You can apply a template by choosing its name from the Template menu, in the 

upper- left corner of the Imposition window. The new settings take effect immediately.

Delete template

Save template

Name of current template
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Saving your work

To close the Imposition window, click the Close box in the upper-right corner. 

TO SAVE THE IMPOSED JOB

1. Click the Close box in the upper-right corner of the Imposition window. 

If the job has changed since it was opened in the Imposition window, you are 

prompted to save it.

2. In the Save As dialog box, type a name for the job and its settings.

3. Click Yes. 

In the Save As dialog box, the name of the original spooled source file appears with a 

new extension (.dbp). If you mistakenly close the Imposition window when you intend 

to keep working, click Cancel in the Save As dialog box. The original PostScript or 

PDF file remains intact, even after the converted file has been edited and saved in the 

Imposition window.

NOTE: When you rename an imposed file, you must include the .dbp extension. 

The extension is required to reopen the file with DocBuilder Pro.

For more information on how files are saved to the server, see “Saving imposed jobs” 

on page 6-26.

Close box
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This chapter provides information about the advanced imposition and editing features 

of DocBuilder Pro. You can use imposition settings to alter various aspects of a job and 

create custom templates.

Mixed Page mode and Fixed Page mode
DocBuilder Pro allows you to perform impositions in two different page modes. 

You can switch between page modes by clicking the corresponding icons at the top 

of the main Imposition window.

Fixed Page mode—allows you to impose documents that contain pages that 

are all the same size.

Mixed Page mode—allows you to impose documents that contain pages of 

different sizes. 

When you open the Imposition window for a document that contains different page 

sizes, Mixed Page mode is selected automatically; you cannot switch to Fixed Page 

mode. When you open the Imposition window for a document that contains a single 

page size, you can select either Mixed Page or Fixed Page mode.

Some imposition settings are available only for Mixed Page mode, and some only 

for Fixed Page mode. The following table notes the settings that are exclusive to 

either mode.

Settings 
panel

Setting
Available in

Fixed Page mode
Available in 

Mixed Page mode

Sheet Size Yes Yes

Creep Adjustment Yes Yes

Orientation Yes Yes

Duplex Yes Yes

Chapter 6:
Advanced 
Features of 
DocBuilder Pro
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Imposition settings
Imposition settings apply only to the job currently displayed in the main window. 

Because these settings usually affect the job’s printed layout, they are saved with the job 

and used whenever the job is opened. For example, as you open jobs saved with 

different layouts, you see the display change accordingly. Changes to imposition 

settings are applied to the current job immediately, but are not saved permanently until 

you save the job itself. 

Layout Rows/Columns Yes Yes

Printer’s Marks Yes Yes

Printer’s Marks: Pull 
into Page Edge

No Yes

Bleeds Yes No

Scale Apply To Not editable; always 
set to All Slots on
All Surfaces

Editable

Scale Mode Available options:
• Scale to Fit
• Custom

Available options:
• Scale to Fit
• Custom
• Fit Width
• Fit Height

Alignment/Offsets No Yes, unless Scale to Fit 
is specified

Finishing Binding Yes Yes

Gang Up Yes Yes

Settings 
panel

Setting
Available in

Fixed Page mode
Available in 

Mixed Page mode
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You can specify imposition settings using controls in the Sheet, Layout, Scale, and 

Finishing panes on the left side of the main window. To view or hide a settings pane, 

click the bar for that settings group.

NOTE: You can change the default unit of measurement for all input fields in the 

Command WorkStation Preferences dialog box. You can also specify any unit of 

measurement in any field that accepts input by adding one of the following 

abbreviations to the new value:

• “i,” “in,” or the inch symbol (") specifies inches, for example: 8.5 i, 8.5 in, 8.5"

• “mm” specifies millimeters, for example: 8.5 mm

• “pt” or “pts” specifies points, for example: 8.5 pts

Sheet settings

Sheet settings allow you to specify characteristics of the paper on which the job is to be 

printed, such as dimensions, thickness, orientation, and whether it is to be printed on 

one or both sides.

Click to view or hide 
the settings panel
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Because these settings affect virtually every other aspect of the imposition process, you 

should specify sheet settings immediately after opening a job in the main window. 

If necessary, you can change the settings later; the job is revised accordingly. 

In general, experimentation with job settings does not cause permanent changes 

(or, potentially, loss of original job data), until the job is printed or saved with the 

new settings. 

Size

You can choose an item from the Size menu to specify the dimensions of a sheet of 

paper and see the change reflected in the main window preview immediately. The Size 

menu includes items representing all page sizes defined by the currently selected 

copier’s PostScript printer description (PPD) file. To choose a custom size, enter the 

width and height of the custom page. If you do not specify units for your custom 

size values, DocBuilder Pro uses the default units specified in the Edit >Preferences 

dialog box.

When specifying a sheet size setting, consider the size of the final output. During 

imposition, DocBuilder Pro automatically scales pages, if needed, to fit the sheet’s 

maximum imageable area. The area does not necessarily extend to the edges of the 

sheet. For example, if you perform 1-Up imposition of 8.5x11 pages onto 8.5x11 

sheets, the final pages will be scaled smaller than 8.5x11. To retain your original page 

sizes, specify a sheet size large enough to accommodate the imposed pages 

without scaling.

Creep Adjustment

Choose either Plain or Thick from the Creep Adjustment menu, or enter a value 

(between 0 and 2 inches, or the equivalent in another measurement unit) to specify the 

thickness of the sheet. When saddle-stitched binding is specified, DocBuilder Pro uses 

this value to compensate automatically for binder’s creep (see “Shingling and creep” on 

page A-8). 

NOTE: Even if you select Thick from the Creep Adjustment menu, your job still 

prints on Plain paper, unless you specify Thick paper in the job properties. For more 

information on changing job properties from Command WorkStation, see “Viewing 

and overriding print settings” on page 3-15.
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Orientation

Use the Orientation menu to specify the orientation of a sheet. As an alternative to 

rotating the sheet, perform custom rotations on any page in the main window, as 

described in “Rotating pages” on page 6-22.

Duplex

Use the Duplex menu to specify the relationship of content areas on opposing sides of 

a sheet. Specify On for duplex (two-sided) printing or Off for simplex (one-sided) 

printing.

When you choose On, the job is printed as duplex using a Top-Top setting, meaning 

that the tops of pages on opposing sides of a sheet are located on the same edge (usually 

the preferred choice for imposed book layouts). 

Layout settings

A layout is a plan that specifies the number, ordering, and rotation of page images on 

the sheet. DocBuilder Pro supports layouts of up to 25 pages per sheet, in a matrix of 

up to 5 rows by 5 columns (50 pages duplex). All combinations of rows and columns 

allow gang printing; however, only Gang Up layouts in the 5x5 matrix support 

imposition.

NOTE: If the number of pages in your job does not divide evenly into the number of 

rows and columns in the layout you select, you may see some sheets with blank spaces. 

The layout you select should correspond to the number of pages in your job.
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Rows

Click the Rows up and down arrows to specify the number of rows (up to five) in a 

layout, or specify the number of rows in the layout by typing a value in the Rows field. 

Changes to the Rows value are reflected immediately in the main window, whether you 

are in Layout or Preview mode.

The Rows value interacts with the Columns and Scale settings. When you choose a 

value that causes content to extend beyond the edge of the sheet, DocBuilder Pro 

provides a visual warning. For more information, see “Clipping indicators” on 

page 6-12. 

When you change the Rows value, you are prompted with a message that all custom 

page edits applied to the job (Add, Delete, or Duplicate) are canceled.

Columns

Click the Columns up and down arrows to specify the number of columns (up to five) 

in a layout, or specify the number of columns in the layout by typing a value in the 

Columns field. Changes to the Columns value are reflected immediately in the main 

window, whether you are in Layout or Preview mode.

The Columns value interacts with the Rows and Scale settings. When you choose a 

value that causes content to extend beyond the edge of the sheet, DocBuilder Pro 

provides a visual warning. For more information, see “Clipping indicators” on 

page 6-12. 

When you change the Columns value, you are prompted with a message that all 

custom page edits applied to the job (Add, Delete, or Duplicate) are canceled.
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Printer’s Marks

Select Printer’s Marks to add trim, fold, and job information to all sheets in a job. 

For background information on printer’s marks, see page A-4.

NOTE: Not all layouts display all of the Printer’s Marks. For example, if the layout you 

select does not require that the sheet be folded, fold marks are not displayed, even if 

you selected them in the Define Marks dialog box.

Because the set of marks required varies according to the job, DocBuilder Pro allows 

you to define the set of printer’s marks displayed. For example, ganged-up business 

cards do not require fold marks, while a 4x4 book layout does. To specify which marks 

are shown, click Define and choose options in the Define Marks dialog box.

The Define Marks dialog box allows you to enable or disable trim marks, fold marks, 

and the individual elements of the job label. The job label stores descriptive text used 

for the job name, sheet information, and date and time. You can also enter values 

(from –72 to +72 points, –1.0 to 1.0 inch, or –25.4 to 25.4 mm) in the Horizontal 

Fold mark

Trim marks

Job label
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Offset and Vertical Offset fields, to fine-tune the placement of trim marks and fold 

marks. In Mixed Page mode, you can select Pull in to Page Edge to align trim marks 

and fold marks with page boundaries. 

Offset—The Horizontal Offset and Vertical Offset fields determine the gap between 

the printer’s marks and the trim lines on the page. This allows you to move the printer’s 

marks away from the final trimmed area of the page. A positive offset moves the 

printer’s marks out from the center of the page, and a negative offset moves the 

printer’s marks closer to the center of the page. 

Properties—Click Properties to customize the appearance of trim marks and fold 

marks. You can specify the horizontal and vertical lengths of marks (from 1 to 

216 points), type (dotted or solid), width (from 1 to 3 points), and color.

10 point horizontal offset

10 point vertical offset



66-9 Imposition settings

NOTE: The Printer’s Marks option enables marks globally throughout a job. To disable 

or enable an individual mark, press the Ctrl key and click the mark directly in the 

imposition window. Disabled marks are indicated by an “X”.

Bleeds

The Bleeds option moves the trim marks into the image by the amount you specify to 

ensure that the printed area extends beyond the edge of the trimmed sheet. 

Ctrl-click to disable/enable mark

Non-imageable area

Trim marks

Image
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To specify horizontal and vertical bleed amounts for a job, click Define in the Layout 

panel and enter values (from 0 to 72 points, 0 to 1 inch, or 0 to 25.4 mm) in the 

Define Bleeds dialog box.

The Bleeds option is not available in Mixed Page mode.

NOTE: When you specify a bleed, you move the trim marks into the page by the bleed 

value on the top and the bottom of the page, and on both sides of the page, reducing 

the size of your finished page by twice the bleed amount. If you plan to use bleeds, 

design your image to be slightly larger than the size of the final, trimmed page and 

select a larger paper size to accommodate trimming. 

Scale settings

Use Scale settings to enlarge or shrink the page by a specified amount. 
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Apply To

In Fixed Page mode, the scaling settings you specify are applied to all pages in a job.

In Mixed Page mode, you can apply scaling to specific slots on sheets. The number of 

slots on a sheet depends on the Rows and Columns values. The slot size is determined 

by dividing the maximum imageable area of the sheet by the number of slots.

Current Slot—Applies scaling to the currently selected page.

Row on All Surfaces—Applies scaling to all pages on all sheets that are located in the 

same row as the currently selected page.

Columns on All Surfaces—Applies scaling to all pages on all sheets that are located in 

the same column as the currently selected page.

All Slots on All Surfaces—Applies scaling to all pages in the job.

Scale Mode

Choose a scaling option from the Scale Mode menu:

Scale to Fit—Scales page(s) to best fill the slot without printing past its edge. Scale to 

fit is the default mode. 

Fit Width—Scales page(s) to fill the width of each page slot on the sheet. This option is 

not available in Fixed Page mode.

Fit Height—Scales page(s) to fill the height of each page slot on the sheet. This option 

is not available in Fixed Page mode.

Custom—Enables the Scale Factor and Finished Height and Width fields, so that you 

can specify new scaling values. The original height and width values are displayed for 

your reference. When you specify a value, DocBuilder Pro automatically updates the 

other fields to preserve the height-to-width aspect ratio of the page.
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Clipping indicators

If you supply scaling values that would cause the page to print past the edge of the 

sheet, DocBuilder Pro provides a visual warning. When the window is in Layout 

mode, any clipped page edge is highlighted in yellow. When the window is in Preview 

mode, the Clipping icon appears to the left of the Scale Factor field. In addition, the 

appearance of the page preview itself makes scaling problems obvious—content 

truncates at the edge of the preview sheet, just as it would on a printed sheet. 

Alignment and Offsets

The Alignment and Offsets settings are enabled when you choose Fit Height, Fit 

Width, or Custom from the Scale Mode menu in Mixed Page mode. You cannot 

change Alignment and Offsets settings in Fixed Page mode.

Clipping icon

Clipped page edge
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The Alignment controls allow you to specify the placement of a page within its 

predefined slot on the sheet. For example, if the page has been scaled smaller than 

the slot, you can align the page to the upper-left corner of the slot by clicking the 

Alignment control corresponding to that position. 

Fine-tune the placement further by entering values (from –5184 to +5184 points) in 

the Offsets fields. Offset values are calculated in reference to the alignment position, 

and reset to zero when you specify a new alignment.

Click to specify 
upper-left alignment

Page is aligned in slot
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Finishing settings

In the Finishing pane, you specify binding and gang printing settings. 

Binding

To enable binding settings and disable gang printing, select Binding. When binding 

settings are enabled, you can specify the binding method, the binding edge of each 

page (left or right), and the number of pages per saddle group. DocBuilder Pro 

compensates automatically for binder’s creep according to the specified binding 

method, the number of pages in a saddle group, the layout in use, and the size of 

the job.

NOTE: If you are using a layout with more than two columns or rows, the Binding 

selection is unavailable.

You can specify the following binding edge options:

Left Edge—Specifies binding across the left edge of the booklet. The booklet reads 

from left to right.

Right Edge—Specifies binding across the right edge of the booklet. The booklet reads 

from right to left.

You can specify any of the following binding methods:

Saddle—Specifies a group of folded sheets stitched or stapled on a common, centered 

fold line. Saddle-stitched binding is the most common type of binding, and is usually 

used for booklets.



66-15 Imposition settings

Perfect—Specifies signatures folded and stacked for binding. The spine edges are 

trimmed and glued together.

Nested Saddle—Specifies a combination of saddle and perfect binding methods. 

As with saddle stitching, pages are grouped together and stapled or stitched across a 

common center fold. The saddle groups are then stacked one on top of another and 

glued, as with perfect binding. 

When imposing a book for nested saddle binding, specify the number of pages in each 

saddle group by entering a value in the Groups of field. As the number of pages in a 

saddle group increases, the effect known as binder’s creep becomes more prevalent 

(see page A-8). DocBuilder Pro shifts images on the page to compensate automatically 

for creep, according to the value in the Groups of field, the value in the paper thickness 

field, the specified binding type, and the ordering and orientation of pages specified by 

the current layout.

Gang Up

To enable gang printing and disable binding settings, select Gang Up. In gang 

printing, you place multiple pages on a sheet for “collate and cut” finishing, rather 

than having DocBuilder Pro impose them in the order required by a particular 

binding method. 

A collate and cut layout reorders pages in a manner that causes them to fall into easily 

collated stacks when the sheets in the job are cut into individual pages. The use of such 

a layout may allow multiple small jobs to be printed on a single sheet; thus, gang 

printing is commonly used as a means of saving paper when printing small jobs on 

copiers that use large sheets, and when printing jobs such as business cards or labels. 

To disable gang printing and enable binding settings, select the Binding setting. When 

gang printing is disabled, DocBuilder Pro imposes pages in the order defined by the 

current layout. 
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You can specify any of the following Gang Up methods:

Repeat—Places multiple copies of a page until the sheet is filled; for example, when 

printing both sides of a sheet, the front side of the first sheet is filled with images of 

page one, and the back side is filled with images of page two; the front side of the 

second sheet is filled with images of page three, and the back side is filled with images 

of page four; and so on, until all pages in the job are imaged.

Documents laid out in this order tend to be collated more easily than when 

printed in another order. The Repeat option enables what is commonly known as 

“step-and-repeat” printing. Step and repeat is most often used when printing multiple 

copies of a single document; for example, when printing business cards, you would 

print multiple copies of the same image to fill a larger sheet. 

Unique—Places pages in an arrangement that is often more appropriate for printing 

a single copy of a job. This option does not fully collate itself (hand collating is 

necessary), but optimizes the sheet size while limiting the run to a single copy.



66-17 Imposition settings

Unique-Collate Cut—Places pages in an arrangement that allows the pages to fall into 

the correct order when the sheets are stacked and cut. This option minimizes the need 

for collating by hand and is most appropriate for printing single copies of a document.
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Modifying the layout manually
Whether you apply a predefined layout or specify custom settings, you can manually 

modify a job’s layout in the following ways:

• Reorder pages.

• Add, duplicate, and delete pages.

• Rotate pages.

• Set gutter sizes.

NOTE: Specify the following settings before making any manual changes to the layout: 

Orientation, Duplex, Rows, Columns, and Binding. If you specify any of these settings 

after making manual changes, you will be prompted with a message informing you 

that the manual changes will be cancelled.

Reordering pages in Layout mode

When you impose a job, its pages are automatically arranged in a particular order, 

according to the layout you select. Each page number in Layout mode represents the 

page from the source document that DocBuilder Pro images in a designated position 

on the finished sheet. However, to reorder individual pages manually, arrange them in 

the main window. To assign a different page to a particular location in the layout, use 

the following procedure.

TO REORDER PAGES

1. Verify that Layout mode is selected.

2. Select the location’s current page number. 

You can also press Tab to move to the next slot in the layout, or press Shift + Tab to 

move to the previous slot in the layout. 

3. Type the new page value and press Enter. 

You can add a blank cover page by typing 0 (zero) for any page number. 

Page 0 is printed as a blank page.
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NOTE: When you use this procedure to reorder pages, the page number you enter 

overwrites the original. For example, if you typed Page 3 in place of Page 5, you will 

now have two of Page 3 and no Page 5. Also, you cannot enter a page number that 

does not already exist in your job. For example, if your job has 10 pages, you cannot 

type 12.

Adding, duplicating, and deleting sheets

You can add, duplicate, or delete sheets by right-clicking any sheet in Preview or 

Layout mode.

TO ADD OR DUPLICATE SHEETS

1. Right-click a sheet in Preview or Layout mode and choose Add Sheet(s) or Duplicate 

Sheet from the menu that appears.

2. If you are adding sheets, specify the number of sheets to add.
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3. If you are duplicating sheets, specify the number of the sheet to duplicate.

4. Select the location to insert added or duplicated sheets and click OK.

TO DELETE SHEETS

1. Right-click a sheet in Preview or Layout mode and choose Delete Sheet(s) from the 

menu that appears.

The Delete Sheet(s) dialog box appears.

2. To delete a single sheet, select Delete Sheet and specify the number of the sheet you 

want to delete.

To delete a range of sheets, select Delete All Sheets After and specify the starting 

number of the sheet range to delete, or select From and enter values for the start and 

end numbers of the sheets to delete.

A single sheet or range of sheets is deleted, depending on what you specified.

3. Click OK.
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Editing page content

Use the Enfocus PitStop software to edit the content of pages in a job. Installation 

instructions are included with the DocBuilder Pro option. PitStop functions as a 

plug-in that adds enhanced PDF editing tools to Adobe Acrobat. 

NOTE: For best results, make edits to page content before performing sheet-level 

operations such as adding, duplicating, or deleting sheets. Editing page content 

causes the cancellation of all previous sheet-level operations.

TO USE PITSTOP WITH DOCBUILDER PRO

1. Right-click a sheet in Preview or Layout mode and choose Edit Page from the 

menu that appears. 

2. Or, display the full-screen preview for the spooled/held PostScript or PDF job in 

Command WorkStation (see page 4-2), and click the Edit Page icon.

Adobe Acrobat starts and displays the document. The standard Acrobat tools are 

available for use, as well as the PitStop tools, which display with purple lines.

Edit Page icon
(in full-screen preview)

 PitStop
editing tools

PitStop editing tools
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3. Use the PitStop editing tools to edit the document content. 

For instructions on using PitStop, see your online PitStop documentation. To access 

this documentation, choose Help>Plug-In Help>Enfocus PitStop Professional from 

the Acrobat menu.

4. When you have finished editing, click Close in the Acrobat window.

You are prompted to save the changes.

5. Click Yes.

6. Click the Command WorkStation window to bring it to the foreground.

The edited file appears in the full-screen preview window.

Rotating pages

To manually rotate individual pages or sets of pages in a job, display the job in Layout 

mode and click the Rotate icon in the upper-right corner of a page. Rotation is 

performed in 90° clockwise increments for Mixed Page mode, or in 180° increments 

for Fixed Page mode.

If you apply a 90° rotation to a page in Mixed Page mode and then switch to Fixed 

Page mode, the rotation is canceled.

Rotate icon
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TO ROTATE PAGES

1. To rotate a single page, click the Rotate icon on that page. 

2. To rotate all pages in the job, press the Shift and Ctrl keys and click the Rotate icon on 

any page.

3. To rotate all pages in a certain location on the front side of each duplex sheet, press 

the Shift key and click the Rotate icon on any page in that location on any sheet. 

For example, in the preceding graphic, if you press the Shift key and click the Rotate 

icon on Page 8, Page 6 rotates as well, because both pages are in the same location on 

the front side of the sheet.

4. To rotate all pages in a certain location on the front and back sides of each duplex 

sheet, press the Ctrl key and click the Rotate icon on any page in that location on 

any sheet. 

For example, in the preceding graphic, if you press the Ctrl key and click the Rotate 

icon on Page 1, then Pages 2, 3, and 4 rotate as well, because they are in the same 

location on the front and back sides of the sheet.

Setting gutter sizes

DocBuilder Pro defines the locations of gutters for you according to the layout and 

sheet size governing the imposition of the job. In Layout mode, you can specify the size 

of a gutter by entering a value in the gutter size field and pressing Enter. For example, 

perfect-bound jobs typically require larger gutters than saddle-stitched jobs, in order to 

provide room for grinding off the spines and gluing signatures together when the book 

is bound. 

You can also specify a negative gutter value—for example, to join together two pages 

located in adjacent slots, or to offset the effect of an excess bleed value.

16 1 2 5

Sheet 1, 
front side

Sheet 1, 
back side

14 3 4 13

Sheet 2, 
front side

Sheet 2, 
back side

1256111078 9
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NOTE: The size and location of the margin (the area between the outside edge of a 

group of imposed pages and the edge of the sheet) is a function of the particular copier 

associated with the job. You cannot define custom margins. 

Managing templates
You can name and save the current combination of Sheet, Layout, Scale, and Finishing 

settings as a custom template. Choose Preferences from the File menu to set the folder 

or directory in which Command WorkStation saves templates (see “Setting 

preferences” on page 2-28).

You can save all imposition settings in custom templates, except the following: 

• Sheet size setting

• Custom printer’s marks properties

• The Pull into Page Edge setting and custom offset settings for printer’s marks

• The Apply To setting in the Scale pane

• Settings made in Custom scale mode in the Scale pane

• Offsets settings in the Scale pane

• Fixed Page Mode or Mixed Page Mode settings

• Added, duplicated, or deleted sheets

Vertical gutter size field

Horizontal gutter size field

Margin
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TO SAVE IMPOSITION SETTINGS AS A TEMPLATE

1. Click the Save template icon.

2. Type a name for the settings file in the Save Template As dialog box.

When saving a template, choose a descriptive name, such as “4-Up Nested Saddle.” 

If you plan to use the same template for a particular document, name the template 

after the document type, for example, “Status Report.”

3. Click OK or press Enter. 

Apply the template in the same manner as built-in templates, by choosing the template 

from the Template menu.

TO DELETE A SAVED TEMPLATE

1. Select the template you want to delete from the Template menu.

2. Click the Delete template icon.

3. Click OK or press Enter to delete the specified template.

Delete template

Save template

Name of current template
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Tips for using the Imposition feature of DocBuilder Pro
This section provides information that will help you get the most out of the imposition 

features of DocBuilder Pro. 

Page-level operations

Consider the following when editing pages of a job:

• Add a binding offset

You can set gutters on each page independently to allow extra room for binding. 

For more information, see “Setting gutter sizes” on page 6-23.

• Perform all page-level edits in the Preview window

For best results, perform all desired page editing operations in the Preview window 

before applying imposition settings to a file. Although you can perform page edits, such 

as adding, deleting, and duplicating pages, within the main Imposition window, these 

edits will be lost when you apply imposition settings that alter the page layout.

Saving imposed jobs

When you save an imposed job, DocBuilder Pro does the following:

• If new data has been added to the temporary PDF file, it is saved to the EB-105EX 

under the name you specify in the Save As dialog box.

The default name that appears in the Save As dialog box is that of the original 

spool file, with a new extension (.dbp). If you do not intend to overwrite the 

source file, you must enter a new name for the imposed job. The original 

PostScript or PDF remains intact, even after the converted file has been edited and 

saved in the Imposition window. 

• If imposition data has changed, the data is saved to the EB-105EX and associated with 

the new PDF. 

Maintaining associated imposition data separately from the job’s PDF data allows 

DocBuilder Pro to impose in-RIP without modifying the PDF data, and allows you to 

reuse PDF data that has been modified in the imposition process. 
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TO SAVE AN IMPOSED JOB

1. Click the Close Window icon in the upper-right corner of the DocBuilder Pro window. 

2. Enter a name for the imposed job in the Save As dialog box. 

3. Click Yes.
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Fiery WebSpooler and Fiery Spooler duplicate many of the functions and features of 

Command WorkStation. Each provides additional flexibility by allowing job tracking 

and management from multiple platforms over the Internet or an intranet.

• Fiery WebSpooler is accessed with an Internet browser from the EB-105EX 

home page. 

• Fiery Spooler is installed from the User Software CD, and is available for Mac OS 

computers only. To use Fiery Spooler, users need only a network connection to the 

EB-105EX. 

NOTE: The interface of Fiery Spooler for Mac OS computers is virtually identical to 

that of Fiery WebSpooler.

Tracking and managing jobs with Fiery WebSpooler
Use Fiery WebSpooler to perform the following functions from your workstation:

• Override current job option settings.

• Delete jobs and cancel processing.

• Duplicate or rename jobs.

• RIP a job and hold the raster data.

• Hold jobs in the spooled area or the RIPped area.

• Remove raster data from RIPped files.

• Change the priority of jobs.

• Edit and merge raster data jobs.

• Display, print, export, or delete the Job Log. 

Chapter 7:
Fiery WebSpooler 
and Fiery Spooler
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Most of these functions require an Administrator or Operator password. However, 

even without a password, you can log in to Fiery WebSpooler as Guest with 

view-only privileges.

NOTE: Most Fiery WebSpooler commands are identical to those of Command 

WorkStation. For more information on specific commands, see Chapters 2 and 3.

TO ACCESS THE FIERY WEBSPOOLER WINDOW

1. Start your Internet browser. 

2. Enter the IP address or DNS name of the EB-105EX.

Consult the operator or administrator for this information.

The EB-105EX WebTools home page appears.

3. Click WebSpooler on the home page.

4. To log in as Administrator, enter the Administrator password and click OK.

To log in as Operator, enter the Operator password and click OK.

To log in as Guest, click OK, without entering a password.
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The Fiery WebSpooler window appears in a new browser window.

About the Fiery WebSpooler window

Similar to Command WorkStation, Fiery WebSpooler allows you to view EB-105EX 

and copier functions, and an interface from which you can control those functions.

The Fiery WebSpooler window is divided into three areas by Spool, RIP, and Print 

status bars. When the EB-105EX receives print jobs, the Fiery WebSpooler window 

becomes a dynamic display, filled with the names of jobs and their characteristics.

The Spool, RIP, and Print areas of the Fiery WebSpooler window represent the stages 

of printing a job. Jobs come in at the top level (Spool) and drop down to the Print 

level, unless they are held along the way.

The job icons displayed in the Fiery WebSpooler window are explained on page 7-8.
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The RAM status bar indicates the amount of memory in use. The Drive status bar 

indicates the amount of hard disk space in use.

NOTE: In the Fiery WebSpooler window, the background color for the yellow and white 

printer icons is the same.

Spooled jobs—Jobs listed in the area below the Spool status bar are PostScript files 

stored on the EB-105EX hard disk. These jobs were sent to either the Print queue 

(white icons) or the Hold queue (yellow icons).

RIPped jobs—Jobs listed in the area below the RIP status bar are ready to print. They 

have been rasterized (RIPped, or processed for printing) and are waiting, in order, for 

access to the printer. Rasterized jobs can also be held; held jobs are indicated by a 

yellow icon.

Printed jobs—Jobs listed in the area below the Print status bar have already been 

printed. Printed jobs can be stored on the EB-105EX hard disk. The number of jobs 

you can store (from 1 to 99) is defined in Setup.

If you are logged in as Administrator or Operator, you can interact with a job wherever 

it appears in the window by selecting it and choosing a command from the Job menu, 

or by double-clicking the job and setting override options. For more information, see 

“Manipulating job options and job flow” on page 7-5.

Errors—Jobs with an error are shown in red. To display the error, double-click the job. 

Note that you cannot check the job properties or hold a job with an error.

NOTE: If your job does not appear anywhere in the Fiery WebSpooler window, it may 

have already printed; if so, it appears in the Job Log. To view the Job Log, choose Show 

Job Log from the Window menu. For more information on the Job Log, see page 7-18.

If the job does not appear in the Job Log, it may have been moved to the Archive 

window by the operator. The Archive window cannot be viewed with Fiery 

WebSpooler; you must contact the operator or go to the Command WorkStation 

screen to check this.
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Manipulating job options and job flow

Using the commands in the Job menu, you can alter the destinations, priorities, and 

characteristics of jobs that appear in the Fiery WebSpooler window.

To understand the effect each of these commands has on a job, you must understand 

the way the EB-105EX handles PostScript and raster data, and how jobs are activated 

or held in the various stages of processing. For this background information, see 

Chapter 1 before manipulating jobs with Fiery WebSpooler.

Choose this command 
from the Job menu

To do this Raster data is

Delete Job(s) Delete the job(s) from the list. Deleted

Cancel Printing Cancel the currently printing job. Deleted

Cancel RIPping Cancel the currently processing job. Deleted

Duplicate Job(s) Duplicate one or more selected PostScript 
data jobs in the Spool or Print areas (creates 
a reference to the original job, with the same 
name).

n/a
(Duplicate is not available for raster jobs.)

Rename Rename the job (PostScript file with or 
without raster).

Unaffected, but associated with the new 
name
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Hold Hold the job in the current place (except for 
a printed job, which is moved to the Spool 
or RIP area).

Held in RIP area indefinitely, if included 
with job

RIP and Hold RIP the job and hold it in the RIP area. Held in RIP area indefinitely

Print Print the job in its turn (RIP the job first if it 
does not have raster data). Keep the printed 
job in the Print area until the job limit is 
reached.

Temporarily held on the server until the job 
has completed printing

Print and Hold
(like the PPD option 
Save Fast Reprint)

Print the job in its turn (RIP the job first if it 
does not have raster data).
After printing, hold the PostScript data and 
the raster in the RIP area.

Held in the RIP area indefinitely (saved to 
disk)

Process Next Give top priority to this job.
Print the job (or RIP and print) as soon as 
the processor and copier are free, before 
other waiting jobs.

Held in RAM after printing (can be selected 
in the Print area while it remains there), or 
held in RIP area (saved to disk) if 
destination was RIP and Hold

Remove Raster Remove the raster from a job that has raster 
data; leave the PostScript job in place.

Deleted

Override Print Settings Change the print options for the job
(see page 7-7).

Deleted and regenerated, if the newly 
selected options require reRIPping, or 
reprinted with the new settings, if none 
require reRIPping

Thumbnail A Open the selected held raster data job in the 
Thumbnail A window, where you can view a 
full-screen preview of the job, edit the job, 
or merge it with raster data from other jobs. 

Changed if job is edited, unaffected if job is 
only viewed

Thumbnail B Open the selected raster data job (not 
necessarily a held job) in the Thumbnail B 
window for viewing or for merging into a 
job in the Thumbnail A window.

Unchanged

Choose this command 
from the Job menu

To do this Raster data is
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Overriding job option settings

To change the job options of a job, select the job and choose Override Print Settings 

from the Job menu. Click the tabs in the Override Print Settings dialog box to see all 

the job options.

NOTE: For some options, changing the setting requires that the job be reRIPped; 

these options are displayed with an icon to the left of the option name.

The options set here are the same ones you set from the Print dialog box when you 

print from an application. For information about setting and overriding these print 

options, see Appendix A of the Printing Guide.
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Job icons
Three types of icons are used for both active jobs and jobs on hold.

Spool area

The job icons in the Spool area are as follows: 

Icon
Active jobs

(white icons and rows)
Jobs on hold

(yellow icons and rows)

Printer icons

PostScript or raster data 
headed for printing (top) or 
after printing (bottom)

PostScript data headed for Print 
and Hold or job on Hold after 
printing (Hold)

Raster icon

PostScript and raster data 
after printing, ready for fast 
reprint

PostScript data already rasterized 
and held

Spool area icon What it indicates How long you see the job

1 PostScript data from a user on 
the network; no destination is 
defined

Until a destination is chosen

2 PostScript data headed for 
Print

Until the RIP is free

3 PostScript data headed for 
RIP and Hold

4 PostScript data headed for 
Print and Hold
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The Spool area is both the receiving area for jobs from users on the network (Hold 

queue) and the waiting area for jobs that will be RIPped.

Hold queue jobs—When printing requires an operator (because the Print queue and 

Direct connection are disabled), the operator must assign a destination to all jobs 

received from users on the network (Icon 1). Once assigned, jobs move down the 

Spool queue for processing (Icons 2, 3, and 4). All jobs printed to the Hold queue 

require routing by an operator. 

Print queue jobs—When printing does not require an operator, network jobs sent to 

the Print queue appear in the Spool area, where they are displayed with a white printer 

icon (Icon 2). When jobs reach the head of the queue, they are RIPped and printed 

without operator intervention.

Direct Connection—Jobs printed to the Direct connection are not displayed in the job 

lists. They are displayed briefly in the status bars (where they cannot be selected) and 

are included in the Job Log.

RIP area

The job icons in the RIP area are as follows: 

RIP area icon What it indicates How long you see the job

1 Raster data, no destination 
defined; may have been 
printed before and held

Until it is deleted, moved to 
the Archive window, or 
stripped of its raster data and 
sent to the Spool area

2 Raster data headed for Print 
in its turn; no hold defined

Until copier is free to print 
the job
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After a job is rasterized, it goes into the RIP area. The RIP area holds only jobs with 

raster data. Jobs in the RIP area are either waiting for the copier to be free (Print queue 

jobs, Icon 2), or they are being held (Icon 1). Held jobs in the RIP area have already 

been rasterized (RIP and Hold), or they have been printed and their raster data has 

been routed back to the RIP area (Print and Hold).

NOTE: Raster jobs in the RIP area that are waiting to print (Icon 2) cannot be 

manipulated by job commands.

Print area

The job icons in the Print area are as follows:

The Print area, also referred to as the Printed queue, contains jobs that have already 

been printed. These jobs were assigned the Print destination (white printer icon in the 

Spool or RIP areas) without any Hold instructions; therefore, they all have white icons.

NOTE: A job row that appears in light red indicates that an error occurred while 

printing the job. To see the error, double-click anywhere in the row.

While it is printing, a job consists of PostScript and raster data. The raster data in 

RAM is not cleared until memory is needed to rasterize the next job. As long as the 

raster data is intact, the job can be reprinted from the Printed queue. Printed jobs that 

still have their raster data are represented by a white raster icon in the Printed queue 

(Icon 2); jobs with only PostScript data remaining are represented by a white 

PostScript icon (Icon 1). If the job was printed from a held raster job (in the RIP area), 

the raster data in the RIP area remains and can be used to reprint the job after the 

raster data has been cleared from the Printed queue.

Print area icon What it indicates How long you see the job

1 PostScript data only—raster 
data has been deleted

Until the job limit is reached

2 PostScript data and raster 
data

Until memory is needed to 
rasterize the next job
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Previewing, editing, and merging jobs
Fiery WebSpooler includes two thumbnail windows that allow you to preview and edit 

raster data. Use the thumbnail windows in the following ways:

• In Thumbnail A, view the currently printing job as it is RIPping, or any 

raster data job.

• From Thumbnail A, open a full-screen preview of a raster file.

• Using Thumbnail A and Thumbnail B, merge raster data from more than one file, 

even if the files were printed from different applications on different computer 

platforms. 

The job merge features eliminate the limitations of certain software applications. 

You can merge raster pages of documents of different types, and from different 

computer operating systems. You can merge color pages from graphics programs 

with text pages from a word processor. 

Previewing raster jobs

Use Thumbnail A to preview pages of the currently RIPping job. You can also use 

Thumbnail A and Thumbnail B to preview any held raster data job in the RIP area.

The thumbnail windows also allow you to open a thumbnail view of any held raster 

data job in the RIP area and perform electronic collation or document merging. 

For more information about this feature, see page 7-15.

Previewing the currently rasterizing job

To see the progress of jobs as they are RIPped, leave Thumbnail A open in RIP 

Preview mode.
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TO VIEW THUMBNAILS OF THE CURRENTLY RIPPING FILE

1. Click the Thumbnail A tab at the right of the Fiery WebSpooler window.

2. Click the RIP preview icon at the left side of the Thumbnail A window.

In this mode, Thumbnail A displays each page of the currently processing job after it 

has been RIPped.

3. Choose a PostScript file in the Spool or Print area and select RIP and Hold, Print,

or Print and Hold.

As pages are RIPped, they are displayed in Thumbnail A.

4. When you have finished viewing, click the Thumbnail A tab to close the

thumbnail window.

Click to display the 
currently rasterizing job

Click to close the
thumbnail window
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TO VIEW THUMBNAILS OF ANY RASTER DATA FILE

1. Select any raster data job in the RIP area.

2. Choose Thumbnail A or Thumbnail B from the Job menu.

NOTE: Wait until all pages have been displayed before opening another raster file with 

Thumbnail A. If the job contains many pages, it may take some time for the entire job 

to be displayed.

3. When you have finished viewing, click the Thumbnail A or Thumbnail B tab to close 

the thumbnail window.

Click to close the
thumbnail window

Click to open a 
full-screen preview
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Displaying full-screen previews

You can open a full-screen preview of any page in the Thumbnail A window. 

The full-screen preview is a view-only display, and it takes time to retrieve the data.

TO OPEN A FULL-SCREEN PREVIEW

1. In Thumbnail A, select a page and click the Full Preview icon at the left of the window.

You can also display full-screen previews by double-clicking the page in Thumbnail A.

NOTE: If you have edited a job using the thumbnail windows, you must save the edited 

file before you can view full-screen previews of all its pages.

2. To close the full-screen preview, click the “X” button above the preview.

Click to close the
full-screen preview

If scroll bar appears,
click arrows or empty

spaces, or move bar to
scroll up or down

If scroll bar appears,
click arrows or empty

spaces, or move bar to
scroll left or right
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Editing and merging raster files

The ability to work with raster files gives you new opportunities to combine 

documents from different sources into a single file. For example, you can combine 

covers and chapter head pages created in a page layout application with text pages 

created in a word processing application, or customize a slide presentation by inserting 

slides from a different presentation graphics application. 

You can display two raster files at once: a source file and a target file. The target file 

appears in Thumbnail A; the source file appears in Thumbnail B.

NOTE: You cannot create a new PostScript file in this process; you must print the 

merged file, which has references to the original PostScript files. Before editing or 

merging raster files with the thumbnail windows, make sure the source files were 

RIPped using the print option settings you want for the final output.

TO VIEW AND EDIT RASTER DATA JOBS

1. Select a raster data job in the RIP area and choose Thumbnail A from the Job menu.

2. Open the Page menu to see the commands available for pages in Thumbnail A. 

You can also access most of these commands by clicking the icons along the left side 

of Thumbnail A.

Use the slider bar at the bottom of the window to scroll through pages in the job.

Click to open a full-screen 
preview of the page

Click to duplicate a page

Click to delete a page
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Delete—Deletes the currently selected pages.

Duplicate—Duplicates the currently selected pages.

Preview—Opens a full-screen preview of the currently selected page (see “Displaying 

full-screen previews” on page 4-2).

Undo—Reverses the action of recently performed page edits.

3. To move pages within Thumbnail A, click to select the pages and hold down the mouse 

button as you drag the selected pages to the new location.

Shift-click to select multiple, sequential pages; Ctrl-click to select multiple, 

non-sequential pages.

To move pages to a new position, drag until a blue highlight appears in the desired 

position, and then release the mouse button.

If you move the pages on top of existing pages, the pages will be overwritten.

4. When you are finished editing, click the Thumbnail A tab. 

If you have edited the job, you are prompted to save the job. 

5. Enter a new name and click OK.

The new file is now located in the RIP area, ready to print. If you saved the edited file 

with a new name, the original source file remains held in the RIP area.

TO MERGE TWO RASTER DATA JOBS

1. In Thumbnail A, display the job you want to edit.

The file must be a held raster data job in the RIP area.

2. In Thumbnail B, display another held raster job from the RIP area.

The Thumbnail B tab opens a second thumbnail view, which cannot be edited but can 

be used as a source for pages added to the document in Thumbnail A.

NOTE: To merge documents, the page sizes of the source document and the target 

document must be the same. Before editing or merging raster files with the thumbnail 

windows, make sure the source files were RIPped using the print option settings for the 

final output.
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3. In Thumbnail B, click to select the pages and hold down the mouse button as you drag 

the selected pages to the new location in Thumbnail A.

Shift-click to select multiple, sequential pages; Ctrl-click to select multiple, 

non-sequential pages.

To scroll through the pages in Thumbnail A and Thumbnail B, you can drag the slider 

bar at the bottom of the screen, click the empty area to the left or right of the slider bar, 

or click the arrows.

To replace pages, drag Thumbnail B pages on top of pages in Thumbnail A. To add 

pages, drag the pages to a new position in Thumbnail A; a blue highlight appears in the 

new position when the pages are ready to be added.

Multiple levels of undo are available; use Undo to undo all the way back to your first 

edit. There is no Redo function.

NOTE: Make sure to save the merged job before deleting any of the jobs you used to 

create the merged job.

Thumbnail B pages moved into Thumbnail A adopt some specific attributes of the 

Thumbnail A job, such as the document and user name. 

Thumbnail B

Page 1 copied from the
document in Thumbnail B
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4. To close a thumbnail window, click the same tab you used to open it (the Thumbnail A 

or Thumbnail B tab).

5. If you have edited Thumbnail A, you are prompted to save the job. 

6. Enter a new name and click OK.

The new raster file is now in the RIP area, ready to print, together with the original 

source and target files.

NOTE: When multiple users are connected to the EB-105EX via Command 

WorkStation, Fiery WebSpooler, or Fiery Spooler, and one user makes changes to a 

Thumbnail A job, not all users may see the results of those changes. If you are unable 

to view changes in a job, or if selecting a thumbnail window results in a message 

indicating zero pages, close and restart Command WorkStation, Fiery WebSpooler, or 

Fiery Spooler.

Using the Job Log

From Fiery WebSpooler, you can view and print a log of all jobs printed by the 

EB-105EX, including jobs downloaded with Fiery Downloader. 

NOTE: If you logged in as Administrator, you can delete the Job Log from 

Fiery WebSpooler (see page 7-20). The Job Log is not available if you logged in 

as Guest.

TO DISPLAY, UPDATE, PRINT, DELETE, AND SAVE/EXPORT THE JOB LOG

1. Choose Show Job Log from the Fiery WebSpooler Window menu.

2. Select All or specify a date range.
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3. Click OK.

The Job Log appears in a new browser window.

NOTE: The Delete button appears only if you logged in as Administrator.

The Job Log displays each job and information about the job, including status, 

document name, user name, date, start time, end time, process time, page description 

language, file size, device, paper size, media, number of originals, total number of 

pages, and Notes.

The Status column provides the following information about jobs:

4. To update the Job Log, click the Update button.

OK The job printed normally.

ERROR An error occurred during processing or printing.

CANCEL The job was canceled before printing was completed.

Update

Print

Delete

Export
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5. To print the Job Log, choose Print Job Log from the File menu or click the 

Print button.

The information displayed in the Job Log window prints to the current EB-105EX. 

When you print the Job Log, totals are printed for all appropriate columns.

6. If you logged in as Administrator, you can choose Delete Job Log from the File menu 

or click the Delete button to clear the Job Log.

7. To save the Job Log, choose Export Job Log from the File menu or click the Export 

button.

8. In the File name area, enter a name for the Job Log.

9. Browse to the location where you want to save the file, and click Save.

The Job Log is saved as a text file, and the Job Log window reappears.

You can view the information in any application that can read a text file. Items are 

separated by tabs.

To return to the job list, choose Show Job List from the Window menu.

Fiery Spooler for Mac OS computers
For Mac OS, the Fiery Spooler interface is almost identical to that of 

Fiery WebSpooler (see “Connecting to a different EB-105EX from Fiery Spooler” on 

page 7-22). 

Starting Fiery Spooler

Use the following procedure to start Fiery Spooler.

TO START FIERY SPOOLER ON A MAC OS COMPUTER

1. Double-click the Fiery Spooler icon.

2. Select the EB-105EX in the Chooser window.

For information on setting up the connection to the server, see the User Software 

Installation Guide.
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3. Click OK.

4. Log in to the EB-105EX.

• To log in as Administrator, enter the Administrator password and click OK.

• To log in as Operator, enter the Operator password and click OK.

• To log in as Guest, click OK without entering a password.

The Fiery Spooler main window appears.

For details on managing jobs in Fiery Spooler and Fiery WebSpooler, see 

“Manipulating job options and job flow” on page 7-5. For details on the job 

icons that appear in Fiery Spooler, see “Job icons” on page 7-8.

The RAM status bar indicates the amount of memory in use. The Drive status bar 

indicates the amount of hard disk space in use.
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Connecting to a different EB-105EX from Fiery Spooler

Although the Fiery Spooler for Mac OS and Fiery WebSpooler interfaces are nearly 

identical, the method for establishing and changing a connection to the EB-105EX 

differs between the two.

With Fiery Spooler, you can connect to a different EB-105EX using the following 

procedure.

TO CONNECT TO A DIFFERENT EB-105EX

1. Choose Open Fiery from the File menu.

2. Select the EB-105EX in the Chooser window.

For information on setting up the connection to the server, see the User Software 

Installation Guide.

3. Click OK.

The Fiery Spooler main window appears.
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This chapter introduces the basic concepts of imposition and can be used as an 

introductory tutorial for imposing a document that will be printed as a book or 

booklet. For more detailed information on the Imposition main window and its 

components, see Chapters 5 and 6.

Printing books with the Imposition feature of 
DocBuilder Pro
This section describes the process of transforming an application-specific file into a 

bound book; along the way, concepts and terminology are introduced to help you take 

advantage of all the features of DocBuilder Pro. 

Printers and copiers that image documents on standard Letter- or Legal-sized paper at 

high speeds are common in office environments. Although the image quality and 

output efficiency of such devices is adequate for correspondence and office memos, 

they cannot image jobs with complex document layouts, or those that require higher 

resolution or a large number of copies. 

Until recently, the only way around these limitations was to use traditional printing 

systems to impose your document—that is, to arrange its pages in the correct order 

and orientation for printing and a variety of binding styles. You might have used a 

service bureau to access high-volume, high-resolution color printers. However, 

DocBuilder Pro, teamed with digital color copiers, now makes it cost-effective to 

produce short-run, fully-imposed (also called “ganged-up”) documents.

Basics of imposition layout

Commercial offset printers and web presses use wide rolls of paper and large printing 

plates capable of imaging numerous pages on a single sheet. For example, it is common 

for such printers to image up to 32 full-size pages on a single press sheet, a process 

inherently faster than printing a single page at a time. DocBuilder Pro allows you to 

image multiple pages on a single sheet, but the output devices it supports are digital 

color copiers, rather than traditional printing presses. In this manual, the paper on 

which a job is imaged is referred to as the sheet. 

Appendix A: 
Basics of 
Imposition
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The printed sheet is folded into something resembling a booklet with connected pages. 

The folded sheet, called a signature, is then trimmed to the finished size.

For pages to appear in normal reading order and position in the final booklet, their 

ordering and positioning on the sheet must differ from the normal book-reading order. 

You can demonstrate this for yourself using an ordinary sheet of paper. 

TO MODEL AN EIGHT-PAGE BOOKLET

1. Fold the paper in half horizontally.

Fold the top edge of the sheet down to meet the bottom edge.

2. Fold the paper again vertically. 

Fold the left edge of the sheet over to the right edge. Now you have a miniature version 

of a signature. 
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3. Position the signature with the vertically folded edge to the left and the horizontally 

folded edges across the top.

The paper should now resemble a small eight-page booklet (with the tops of pages 

joined at the fold). 

4. Page through the booklet as if you were reading it, and number each page 

sequentially.

Number the front and back of each page—in general, books have content on both 

sides of each page. The front cover of the booklet should be page 1 and the back cover 

of the booklet should be page 8. You can also underline each number to highlight the 

page orientation.

NOTE: Printing on both sides of the sheet is called duplex printing; printing on only 

one side of the sheet is called simplex printing. Not all copiers support duplex printing; 

and of those that do, variations in implementation exist. DocBuilder Pro supports 

duplex printing that corresponds to the print options of the output device.

When you unfold the signature, the page numbering should look something like the 

following illustration.

4 5

1 8

6 3

7 2

Front Back
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Notice that:

• The folds subdivide the sheet into areas representing pages in the final booklet.

• Page numbers do not appear in book-reading order.

• Some page numbers are upside down.

Some pages must be printed upside down on the sheet in order for them to appear 

right-side up in the final booklet, and pages must also be printed out of numerical 

sequence on the sheet in order for them to appear in numerical sequence in the final 

booklet.

This process of folding paper and numbering pages to approximate the finished piece 

is called making a folding model, and it is a common first step in planning a print job. 

The folding model provides valuable information about page placement, which you 

can use to create a plan, or sketch, of how pages are placed on the sheet. This plan is 

called a layout. 

DocBuilder Pro frees you from the tedious and error-prone process of creating accurate 

physical models of the imposed book in order to lay out pages. With DocBuilder Pro, 

you simply open the source file to be imposed and specify how many rows and 

columns of pages to image on a sheet. DocBuilder Pro simplifies this process even 

further by providing predefined layouts for common impositions such as booklets and 

brochures. You can also save your own custom layouts for easy reuse.

Printer’s marks

In addition to specifying the placement of pages on a sheet, the layout also specifies 

how the finished sheet will be cut and folded. For example, the layout specifies whether 

the large finished sheet is folded and cut to create a booklet, or simply folded (and not 

cut) like a map. 
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A DocBuilder Pro layout designates the location of folds, cuts, and other elements by 

means of markings called printer’s marks, which appear on the printed sheet outside 

the main content area of the job. 

• The job label comprises descriptive text such as the name of the job, a sheet 

identifier, and the date and time the sheet was printed. 

• The location of a fold is defined by a dotted line called a fold mark; similarly, the 

location of a cut is defined by a solid line called a trim mark. 

• Specialized marks also define the size and locations of margins (space surrounding 

the page’s content area), gutters (space between pages), and bleeds (extensions of 

content beyond a trim mark; used to ensure that the printed area extends to the very 

edge of a trimmed page). 

DocBuilder Pro makes it easy to set up gutters and specify a set of printer’s marks to 

image on the finished sheet, as shown in the following illustration.

Job label

Trim marks

Gutter

Margin

Fold mark
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Additional sheets

A book layout must also adjust the placement of pages according to the total number 

of pages in the job. For example, a book is often composed of more pages than can be 

printed on a single sheet. When the number of pages in the book is a multiple of the 

number of pages on a sheet, the same layout plan is used to place pages on additional 

sheets, until all of the pages in the book are printed. However, if the total page count is 

not an even multiple of the number of pages in the layout, one signature may be laid 

out to accommodate the discrepancy. 

For example, if your layout places 8 pages on a sheet and the total page count in the 

book is 12, one of its signatures holds only 4 content pages, with the rest of the space 

on the sheet blank. If you do not want blank pages in the middle of the finished book, 

insert blank pages intentionally, for example after the cover page, after the table of 

contents, or between chapters. To insert blank pages, open the job in the Thumbnail A 

window, right-click the page you want to add the blank to (or pull down the Page 

menu), and select Insert blank page. 

DocBuilder Pro allows you to add blank pages or add, delete, and rearrange pages from 

multiple source documents easily, so you can quickly preview the results of page 

manipulations. 
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Binding methods

A book layout also specifies the means by which sheets are gathered and bound. 

Stitching or stapling finished pages across a common center fold, or spine, is called 

saddle stitch binding, and the stitched pages are called a saddle. Multiple folded sheets 

can be stitched into the same saddle as a group. Stacking signatures, grinding the 

spines off, and then gluing them together is called perfect binding. You can combine 

saddle stitch and perfect binding methods by stacking two or more groups one on top 

of another on a common fold line and gluing them together; this is called a nested 

saddle. 

The binding method you use affects the order in which pages are placed on the sheet; 

for example, the page ordering used to perfect bind a book must be different from that 

used to saddle stitch the same job. Thus, your layout must specify the method by 

which the finished job will be bound. 

The choice of a binding method is determined by the job’s size, complexity, and 

budget. Saddle stitch binding is very cost-efficient, but is more suitable for small 

booklets than for large jobs. (A rule of thumb is that saddle stitch binding works best 

for booklets or brochures with a maximum of 88 pages.) Conversely, perfect binding is 

more expensive but more suitable for larger jobs.

Saddle Nested SaddlePerfect
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DocBuilder Pro reorders imposed pages automatically according to your choice of 

binding method, which can save a significant amount of time and effort. Consider, for 

example, what must be done when a book that was to be saddle stitched exceeds the 

bindery’s maximum page count and must be reimposed as a perfect-bound book. To 

redo the imposition by traditional means would be labor-intensive; with 

DocBuilder Pro, it takes only moments.

Shingling and creep

All books and brochures use a sheet that is folded to create separate page areas. Because 

the sheet itself has some thickness, each fold causes a very small incremental shift in the 

location of the edge of each page relative to the others. The result is that the edges of 

pages furthest from the saddle’s innermost fold seem to move away from the edges of 

pages closest to the innermost fold. As the number of pages in the saddle increases, so 

does the amount of this shift, which is known as shingling. To counteract the effects of 

shingling (illustrated in an exaggerated manner in the following figure), the bindery 

trims the edges of the finished book to a common edge.

Trimming the bound pages resolves only half of the problem, however—as the edges of 

pages move, so do the content areas imaged on them. The apparent shift of content 

area caused by folding a sheet multiple times is known as creep or binder’s creep. 

The effect of creep is that the content area of pages closer to the innermost fold in a 

saddle appear to move towards the outer margins of the page.

Shingling
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Creep becomes more noticeable as the number of groups in a saddle increases, and its 

effect is most noticeable on pages farthest from the center fold of the saddle. 

Consequently, a book layout must also specify the number of groups in each saddle 

because the number of groups in each saddle affects the amount of creep that needs to 

be accounted for.

Compensating for creep is tedious, exacting work that DocBuilder Pro does for you 

automatically when you change any aspect of the imposed job that is affected by creep. 

Gang-Up printing

Layout is essential for defining the elements of complex print jobs, such as booklets 

and books, but it can also be useful for smaller jobs. Consider, for example, how you 

might approach the task of printing business cards. It is slow, wasteful, and expensive 

to print a single business card per sheet, when you can repeat the image of the business 

card until the entire sheet is filled. This printing technique is known as Gang Up 

Repeat because the image is repeated in each page area, or step, on the sheet. After 

printing, the sheet is cut apart to produce individual cards. 

Creep

Gang Up Repeat layout
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This job can be made even more efficient by eliminating the gutters between cards, 

allowing you to reduce significantly the number of cuts required to separate each card 

from its neighbor. Defining zero-width gutters on a shared cut line in this manner is 

called using a common blade for those cuts. 

If you need to print business cards for several different clients, you could perform a 

Gang Up Repeat printing job for each, but you might still wind up wasting paper 

and time if the jobs do not fit easily into a simple multiple of sheets. A more efficient 

approach is to print several jobs on a single sheet, and then print that sheet as many 

times as required. The technique of printing multiple jobs on the same sheet is known 

as Gang Up Unique. DocBuilder Pro provides both Gang Up Repeat and Gang Up 

Unique.

Gang Up Unique layout
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This appendix gives descriptions of the built-in templates provided with 

DocBuilder Pro. 

1-Up Full Bleed
The 1-Up Full Bleed layout is used to print one page per sheet. The printer’s marks 

indicate where to cut the paper so that the color content extends to the edge of 

the paper.

The following settings are applied for this layout:

• Bleeds

• Printer’s Marks (trim marks and job label only)

• Scale to Fit

• Gang Up Unique

NOTE: There are no page number restrictions for the 1-Up Full Bleed layout.

Appendix B: 
Templates
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2-Up Perfect

The 2-Up Perfect layout is used to create signatures for a perfect bound book. 

Each sheet is folded once and stacked on top of one another. For more information 

on binding methods, see page A-7.

The following settings are applied for this layout:

• Duplex

• Bleeds

• Printer’s Marks (fold marks, trim marks, and job label)

• Scale to Fit

• Binding Perfect
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The 2-Up Perfect layout should be used with jobs that have multiples of four pages, 

but it can be used with jobs that have any number of pages. Additional blank pages will 

be added if necessary. Pages will be ordered in groups of four so that when folded each 

sheet has four sequential pages. For example:

• 4 pages

• 8 pages

NOTE: The Creep Adjustment option has no effect on this template.

4 1 2 3

Sheet 1, 
front side

Sheet 1, 
back side

4 1 2 3

Sheet 1, 
front side

Sheet 1, 
back side

8 5 6 7

Sheet 2, 
front side

Sheet 2, 
back side



BB-4 Templates

2-Up Saddle

The 2-Up Saddle layout is used to create signatures for a saddle bound book. All of 

the sheets are folded together, one inside the other. For more information on binding 

methods, see page A-7.

The following settings are applied for this layout:

• Duplex

• Bleeds

• Printer’s Marks (fold marks, trim marks, and job label)

• Scale to Fit

• Binding Saddle
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The 2-Up Saddle layout should be used with jobs that have multiples of four pages, 

but it can be used with jobs that have any number of pages. Additional blank pages will 

be added if necessary. Pages will be ordered so that when sheets are folded and stitched 

together into signatures, the pages will be sequential. For example:

• 4 pages

• 8 pages

4 1 2 3

Sheet 1, 
front side

Sheet 1, 
back side

8 1 2 7

Sheet 1, 
front side

Sheet 1, 
back side

6 3 4 5

Sheet 2, 
front side

Sheet 2, 
back side
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3-Up Trifold Brochure

The 3-Up Trifold Brochure layout consists of a single sheet folded into three sections. 

Although the three sections are the same width, the space between each section varies 

so that the leftmost panel can be folded over the other two panels.

The following settings are applied for this layout:

• Duplex

• Printer’s Marks (fold marks, trim marks and job label only)

• Scale to Fit

• Gang Up Unique
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The 3-Up Trifold Brochure layout can be used only with jobs that have six pages. If the 

job contains more or less than six pages, an error message appears. The pages will be 

ordered as follows:

The 3-Up Trifold Brochure is usually folded as shown in the following illustration.

3 6 2 4

Sheet 1, 
front side

Sheet 1, 
back side

1 5
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4-Up Gate Fold

The 4-Up Gate Fold layout is used most often in the case of a four-panel brochure. 

The finished brochure unfolds to double, then four times the original size.

The following settings are applied for this layout:

• Duplex

• Printer’s Marks (fold marks, trim marks and job label only)

• Scale to Fit

• Gang Up Unique
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The 4-Up Gate Fold layout can be used only with jobs that have eight pages. If the job 

contains more or less than eight pages, an error message appears. The pages will be 

ordered as follows:

The 4-Up Gate Fold is usually folded as shown in the following illustration.

3 8 4 5

Sheet 1, 
front side

Sheet 1, 
back side

1 62 7
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4-Up Head to Head

The 4-Up Head to Head layout is used to create booklets from a layout of four pages 

on each side of the printed sheet. By rotating the two topmost pages, the signature can 

be folded both horizontally and vertically, and trimmed. The finished booklet will have 

all pages in the correct order and rotation.

The following settings are applied for this layout:

• Duplex

• Bleeds

• Printer’s Marks (fold marks, trim marks, and job label)

• Scale to Fit

• Binding Saddle
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The 4-Up Head to Head layout should be used with jobs that have multiples of eight 

pages, but it can be used with jobs that have any number of pages. Additional blank 

pages will be added if necessary. Pages will be ordered so that when sheets are folded 

with two folds at 90 degrees, trimmed, and stitched together into signatures, the pages 

will be sequential. Note that although this layout requires two folds, the template 

applies a fold mark on the spine fold only. For example:

• 8 pages

• 16 pages

The 4-Up Head to Head is usually folded as shown in the following illustration.

8 1 2 7

Sheet 1, 
front side

Sheet 1, 
back side

6345

16 1 2 15

Sheet 1, 
front side

Sheet 1, 
back side

14 3 4 13

Sheet 2, 
front side

Sheet 2, 
back side

12561110789
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4-Up Z-Fold

The 4-Up Z-Fold layout allows many panels to be folded on top of one another 

without stressing the folded spine. The most common example is a road map.

The following settings are applied for this layout:

• Duplex

• Printer’s Marks (fold marks, trim marks and job label only)

• Scale to Fit

• Gang Up Unique
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The 4-Up Z-Fold layout is used only for jobs that have eight pages. If the job contains 

more or less than eight pages, an error message appears. The pages will be ordered as 

follows:

The 4-Up Z-Fold is usually folded as shown in the following illustration.

2 3 6 7

Sheet 1, 
front side

Sheet 1, 
back side

4 85 1
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This appendix describes error messages you might see, and provides some 

troubleshooting guidelines should a problem arise with the EB-105EX, Command 

WorkStation LE, or Command WorkStation. If you are unable to resolve a problem 

after referring to this chapter, contact your authorized service/support center. 

Error messages
Refer to the following guidelines if you encounter an error message:

• Error messages can result from problems with the job, the EB-105EX, Command 

WorkStation, Command WorkStation LE, or the copier. When an error interferes 

with printing, you will see a message in the Activity Monitor of Command 

WorkStation or Command WorkStation LE. The status bar that displays the 

message indicates the process in which the error occurred. 

• An error message for the EB-105EX sometimes remains displayed on Command 

WorkStation or Command WorkStation LE even after you resolve the error. There 

might be a brief delay while the EB-105EX communicates the resolution of the error 

to the application. Printing will resume and the Command WorkStation or 

Command WorkStation LE window will be updated after a short delay.

• If you encounter an EB-105EX message alerting you to check the power and cable, 

there may be a problem with the copier power or cable connection. Check to make 

sure the copier is turned on. Make sure the cable connection between the EB-105EX 

and the copier has not come loose. The EB-105EX will resume printing when the 

cable is securely connected to both the EB-105EX and the copier.

• If you encounter an error message stating “ULTRA POST READY/POST ERROR” 

or any error message referring to “Video Diags” or “Video Board”, recycle power on 

the EB-105EX. Press the power switch on the front panel of the EB-105EX to turn 

off the power, wait 10 seconds, and then press the power switch again to turn on the 

power. If the error message persists, contact your authorized service/support 

representative.

• For information on resolving other copier-related errors, refer to the copier 

documentation. You can cancel the pending print job while you attend to a given 

error condition. 

Appendix C: 
Troubleshooting
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Troubleshooting
Before you call for service, follow the suggestions in this section. If you are unable to 

resolve the problem, make a note of the error condition and contact your authorized 

service/support center.

Command WorkStation or Command WorkStation LE does not 
respond

If the Command WorkStation or Command WorkStation LE windows do not update, 

log off and then quit Command WorkStation or Command WorkStation LE. Restart 

Command WorkStation or Command WorkStation LE, or restart the computer. To 

force an exit from Command WorkStation, press Ctrl-Alt-Delete, and use the Task 

Manager to close Command WorkStation. 

If the Command WorkStation or Command WorkStation LE windows do not update, 

or no jobs are displayed, and the mouse has no effect (you cannot select a job or a 

window, use a right mouse command, or select a menu item), the EB-105EX is down 

or network communication has failed.

At the EB-105EX, disconnect and reconnect the network cable, and try printing a Test 

Page or Configuration page. If that fails, restart the server.
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Command WorkStation fails to connect to a EB-105EX

If Command WorkStation cannot connect to a server that was connected previously, 

you may need to reconfigure the connection.

1. Choose Exit from the Command WorkStation File menu.

2. In the C:\Windows folder, move the Efinl.ini file to another folder. 

If the Efinl.ini file contains a limited amount of configuration information that is easily 

recreated (information for only one or two servers), you can delete the file altogether. 

A new Efinl.ini file will be created in the C:\Windows folder when you reconfigure the 

connection.

If the Efinl.ini file contains configuration information for several servers, or 

information that is not readily recreated, keep the Efinl.ini file as a backup.

3. Print a Configuration page.

You will use the information on this page to configure the connection to the server.

4. Start Command WorkStation.

5. When you are prompted to configure a server connection, click OK. 

To configure the connection, follow the instructions in the User Software Installation 

Guide.

6. If you still cannot connect to the EB-105EX, reinstall the Command WorkStation 

software. 

For details, see the User Software Installation Guide.
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Unexpected printing results

If this happens This is the problem

The job settings are not 
carried out as you expected.

If the user printed from Mac OS, there may be two 
conflicting print settings. You can check the job properties by 
double-clicking the job. For a table of job properties and 
conflicting properties, see the Printing Guide. Notify users of 
these conflicts so they can avoid them in the future.
If you expected the settings you see in the Properties window, 
be aware that the Copies field does not currently reflect user 
settings, and that Page Range and Scale percent are All and 
100%, respectively, unless they were changed after being sent 
for printing.

The job does not print. Some printing errors may be displayed in the Print status bar. 
When the job is in the Printed queue, jobs that had a 
PostScript error are displayed in a light red job row. 
Double-click anywhere in the row to see the error message.

There are font errors. If user-specified fonts that are not resident on the EB-105EX 
are not printing correctly in PostScript files that are 
downloaded by users, request that they embed the fonts in 
the PostScript file or print directly from their application. If 
special fonts are not downloaded automatically when users 
print from applications, the fonts should be downloaded 
directly to the EB-105EX with Fiery Downloader. This can 
be done by the user or the operator, provided the Direct 
connection is enabled. For information about Fiery 
Downloader, see the Printing Guide.



CC-5 Troubleshooting

Clearing the server

Clearing the server is an option that can be used as a last resort if a job persists in the 

system and prevents printing despite attempts to cancel or delete it. Clear the server if 

all other troubleshooting methods have failed. 

Clearing the server deletes all jobs currently saved on the server in any queue, all 

FreeForm master jobs, and all locally archived jobs. It also clears the job log, the index 

of archived jobs, and the index of FreeForm masters.

TO CLEAR THE SERVER

1. On the copier operation panel, press the Printer button.

2. On the Touch Panel, press Menu/Cancel until the following menu is displayed.

3. Scroll down through the menu options and select Run Setup. Using the arrow buttons, 

display Yes to confirm the selection, and select OK.

4. If needed, press the Printer button to display the setup menu on the Touch Panel.

5. In the setup menu, select Clear Server. Using the arrow buttons, display Yes to confirm 

the selection, and select OK.

Print Pages

Scan Job

Suspend Printing

Resume Printing



CC-6 Troubleshooting

Users are unable to connect to the EB-105EX

If users are unable to connect to the EB-105EX, or are unable to find the EB-105EX 

from their workstations, the network administrator may need to troubleshoot their 

network connections, and check settings on the servers they use for printing. If settings 

have changed, it may be necessary to reconfigure the EB-105EX.

For example, if print servers or print queues on a Novell server are renamed or deleted, 

or if accounts or permissions are changed, the EB-105EX administrator may have to 

edit settings or enter new settings in IPX (Novell) Setup to reflect the new 

configuration.

If users cannot connect to the EB-105EX with Fiery Downloader from a Windows 

client computer, you may need to reconfigure the utility’s connection to the server. For 

details, see the User Software Installation Guide.

Mac OS users may be unable to connect to the EB-105EX if a network administrator 

has assigned it to a different zone, or has added zones where previously there were 

none.

If you have configured the EB-105EX and set up client computers and network servers 

according to guidelines in the Configuration Guide and the User Software Installation 

Guide, try printing a Test Page (in Command WorkStation or Command WorkStation 

LE, choose Print Pages from the Server menu).

If you can print the Test Page but still cannot print a document from a remote 

computer, contact the system administrator to troubleshoot the network connection.



CC-7 Troubleshooting

If you are unable to connect, and you cannot print the Test Page, check the copier’s 

touch panel display.

Setup error messages

For information on Setup error messages, see the Configuration Guide.

If this happens Try this

The copier displays a 
diagnostic or error message.

Take the appropriate corrective action, as described in the 
copier manual or in “Error messages” on page C-1.

The copier is not in 
Standby mode.

The copier’s Automatic Power-Off function may have shut 
down the copier. 
Turn the copier on, and then try printing a Test Page again 
when the copier has warmed up.

You still cannot print a 
Test Page.

Make a copy. If you can make a copy, restart the EB-105EX, 
and when you see Idle on the status line of the EB-105EX 
display, try printing a Test Page again. If the Test Page still 
fails to print, contact your authorized service/support center.
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